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TUYÊN BỐ BẢN QUYỀN 

 

Tài liệu này thuộc loại sách giáo trình nên các nguồn thông tin có thể được phép 

dùng nguyên bản hoặc trích dùng cho các mục đích về đào tạo và tham khảo. 

Mọi mục đích khác mang tính lệch lạc hoặc sử dụng với mục đích kinh doanh thiếu 

lành mạnh sẽ bị nghiêm cấm. 
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LỜI GIỚI THIỆU 

Ngày nay khi công nghệ thông tin phát triển mạnh mẽ kéo theo sự phát triển 

của các ngành nghề khác. Các công ty, doanh nghiệp trong lĩnh vực kinh doanh ngày 

càng nhiều, càng có sự cạnh tranh gay gắt. Mỗi công ty cần xây dựng một hướng đi và 

hình ảnh riêng cho mình nhằm không bị trùng lắp với các đối thủ cạnh tranh. Xây 

dựng logo hay các biển quảng cáo cho mình cũng được chú trọng. Có nhiều phần mềm 

thực hiện công việc thiết kế logo, biển hiệu nhưng phổ biến nhất trên thế giới hiện nay 

vẫn là bộ công cụ Corel Graphic Suite với các công cụ Corel Draw, Corel Photo- 

Paint, Corel Capture… trong đó Corel Draw là được sử dụng thông dụng nhất. 

Tập giáo trình này hướng dẫn chúng ta những kiến thức về ảnh Vectơ, ảnh đồ 

họa , các thao tác cơ bản trên Corel, Các nội dung được trình bày trong giáo trình 

nhằm mục đích trang bị cho nguời học có kỹ năng về thiết kế các yêu cầu mà lĩnh vực 

ngành mình đang theo học. 

Trong quá trình biên soạn không thể tránh khỏi những sai sót, rất mong các 

bạn thông cảm cũng như mong nhận được ý kiến đóng góp từ các bạn để có thể hoàn 

thiện hơn giáo trình về sau này! 

 

 

Hà Nội, ngày ..... tháng…..năm 2019 

  Biên soạn 

Khoa Công Nghệ Thông Tin 
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CHƯƠNG TRÌNH MÔ ĐUN THIẾT KẾ ĐỒ HOẠ COREL DRAW 

 

Tên mô đun: THIẾT KẾ ĐỒ HOẠ COREL DRAW 

Mã mô đun: MĐ 18 

Thời gian thực hiện mô đun: 90 giờ; (Lý thuyết: 30 giờ; Thực hành: 56 giờ; 

Kiểm tra: 4 giờ) 

 

I. VỊ TRÍ, TÍNH CHẤT MÔ ĐUN 

Vị trí: 

Là mô đun chuyên ngành của nghề Ứng dụng phần mềm, được thực hiện 

vào kỳ thứ 2. Mô đun được thực hiện sau khi học song các mô đun kỹ thuật cơ 

sở. 

Tính chất: 

Môdun Corel Darw giới thiệu các công cụ vẽ đồ hoạ vector. Sử dụng và biên 

tập các mẫu màu trên đối tượng vector. Ngoài ra Corel Draw hỗ trợ xử lý các 

ảnh Bitmap và trao đổi dữ liệu với các ứng dụng khác. 

 

II. MỤC TIÊU MÔ ĐUN 

- Kiến thức: 

 Trình bày được chức năng của từng công cụ vẽ; 

 Trình bày được các cách sử dụng công cụ vẽ để tạo ảnh Vector và ảnh 

Bitmap. Phân tích sự khác nhau và phạm vi ứng dụng của ảnh Vector và 

ảnh Bitmap; 

 Thực hiện được các bước tạo và hiệu chỉnh hiệu ứng; 

- Kỹ năng: 

 Vận dụng thành thạo các công cụ vẽ để tạo ảnh vector và áp dụng thành 

thục các hiệu ứng lên đối tượng; 

 Hình thành ý thức lao động là phải khẩn trương có kỷ luật, có trách 

nhiệm và sáng tạo. 

- Năng lực tự chủ và trách nhiệm: Có phẩm chất đạo đức, kỷ luật tốt, tích 

cực nghiên cứu học hỏi nâng cao trình độ. 
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III. NỘI DUNG MÔ ĐUN 

1. Nội dung tổng quát và phân phối thời gian 

 

STT 

 

Tên các bài trong mô đun 

Thời gian (giờ) 

Tổng 

số 

Lý 

thuyết 

Thực 

hành 

Kiểm 

tra 

1 Bài mở đầu 2 2 0 0 

2 Bài 1: Giới thiệu phần mềm Corel và thiết 

kế vẽ cơn bản 
18 6 12 0 

3 Bài 2: Thiết kế nâng cao 30 5 24 1 

4 Bài 3: Văn Bản và các hiệu ứng 10 3 6 1 

5 Bài 4: Xử lý các đối tượng nhúng 20 5 14 1 

6 Bài 5: Bộ công cụ hỗ trợ Corel Draw 10 5 4 1 

 
Cộng 90 30 56 4 
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BÀI MỞ ĐẦU 

Mã bài MĐ18-00 

1. Ảnh vector và ảnh đồ hoạ 

1.1. Ảnh Vector 

Ảnh vector được tạo thành từ các đối tượng hình học, chúng thường được 

biểu diễn dưới dạng các hàm toán học. Như vậy ta có thể thực hiện các thao tác di 

chuyển, định kích thước, thay đổi màu sắc, thu phóng ảnh mà không làm suy giảm 

chất lượng của ảnh. Khác với ảnh đồ họa, ảnh vector không phụ thuộc vào độ phân 

giải. 

1.2. Ảnh đồ họa 

Ảnh được tạo từ các phần tử là các điểm ảnh (pixel – picture element) riêng 

biệt. Ảnh đồ họa còn được gọi là ảnh mành (raster) vì các điểm ảnh được xếp theo 

các hàng, cột; mỗi điểm ảnh có một giá trị màu để biểu diễn màu tương ứng của nó. 

Ảnh đồ họa phụ thuộc nhiều vào độ phân giải, đó là vì nó chứa một số 

lượng cố định các pixel để trình bày dữ liệu ảnh. Và cũng vì vậy, ảnh đồ họa có thể 

mất các chi tiết và xuất hiện sự gồ ghề khi phóng lớn hoặc được in ở độ phân giải 

thấp. 
 

 

 

Sự khác nhau giữa ảnh Vector và ảnh Raster 

 

2. Phần mềm đồ hoạ cho ảnh vector 

Phần mềm đồ họa cho ảnh vector thường được sử dụng nhất là Corel Draw. 

3. Trình tự cài đặt Corel Draw 

Để cài đặt CorelDraw 12 vào máy tính bạn cần có máy tính có cấu hình phù 

hợp, tối thiểu là Pentium III 500, Ram 128 trở lên để có thể chạy được phần mềm. 

Cần có đĩa CD cài đặt CorelDraw 12. 
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- Tra đĩa CD vào ổ CD của máy tính 

- Thông thường đĩa sẽ chạy tự động với tùy chọn Autoplay và bạn sẽ thấy 

màn hình chào của CorelDraw 12 xuất hiện. 

- Nếu CD không chạy tự động, (có nhiều cách để bạn có thể cài) bạn có thể 

vào Menu Start, chọn Control Panel -> chọn Add or Remove programs -> nhấp tùy 

chọn Add New program - > chọn nút CD or Flopy -> sau đó chọn đường dẫn là ổ 

đĩa CD ở mục Browse. 

- Bạn nhấn mục Install CorelDraw Suite 12 sẽ thấy xuất hiện mục 

Welcome to Corel Draw Suite 12 

- Trong mục Lisence Agreement bạn nhấp vào tùy chọn I Accept the term.. 

sau đó nhấn next 

- Trong mục Customer Information bạn gõ tên người sử dụng cũng như tên 

bộ phận vào các ô để trống, trong mục serial number bạn nhập các dãy chữ và số mà 

CorelDraw 12 cung cấp ( bằng cách kích phải chuột vào đĩa CD chọn mục Serial để 

lấy mật mã) -> next 

- Trong mục Language bạn chọn ngôn ngữ mình muốn hiển thị, thông 

thường ta chọn English 

- Bạn chọn ổ đĩa để cài phần mềm CORELDRAW 12 vào máy tính, thông 

thường ta cài vào ổ C. 

- Chờ máy tính Install phần mềm, cuối cùng nhấn Finish để hoàn tất cài đặt 
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Bài 1 : GIỚI THIỆU PHẦM MỀM COREL VÀ THIẾT KẾ VẼ CƠ BẢN 

Mã bài MĐ18-01 

Mục tiêu : 

- Trình bày được các công cụ vẽ và pha màu của Corel Draw; 

- Nêu được các cách đổ màu cho đối tượng vẽ; 

- Vận dụng thành thạo vào thiết kế các ảnh vector và các bài tập thực tiễn; 

- Hình thành ý thức lao động là phải khẩn trương có kỷ luật, có trách nhiệm và 

sáng tạo. 

1. Giới thiệu Corel Draw 

Sau khi khởi động phần mềm đồ họa CorelDRAW 12 ta sẽ thấy xuất hiện bảng sau: 
 

 

Truy cập vào một trong sáu tùy chọn trong bảng để bắt đầu làm việc với CorelDRAW 

12 

1.1 Các thành phần cơ bản của màn hình 
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Để bắt đầu làm việc trong CorelDRAW 12 ở một trang thiết kế mới ta có thể nhấp 

vào tùy chọn New, bạn sẽ thấy xuất hiện màn hình làm việc của một trang thiết kế 

hoàn toàn mới. 

Giới thiệu màn hình làm việc của CorelDRAW 12: 
 

 

- Thanh tiêu đề: hiển thị tiêu đề hay tên của tệp tin 

- Thanh trình đơn: thanh chứa các “thực đơn” hay các tùy chọn 

- Thanh công cụ: thanh hiển thị công cụ chuẩn của CorelDRAW 12 

- Thanh đặc tính: thanh hiển thị các thuộc tính tương ứng hỗ trợ cho từng công cụ 

- Thước: hiển thị đơn vị đo của đối tượng trên màn hình làm việc 

- Hộp công cụ: Chứa các công cụ ứng dụng trong thiết kế của CorelRAW 12 

- Thanh cuốn: hỗ trợ trong việc di chuyển tới vùng làm việc bạn mong muốn 

- Dòng tình trạng: hiển thị các chỉ dẫn sử dụng công cụ, tình trạng của đối tượng 

được lựa chọn hoặc đang sử dụng. 

- Bảng màu: chứa các tùy chọn về màu tô nền và đường viền cho đối tượng. 

1.2 Các chế độ quan sát 

1.2.1 Thước –Ruler 

Thước là một thành phần mà bạn có thể tùy chọn hiển thị hay không hiển thị trên 

màn hình làm việc của CorelDRAW: trên thanh menu bạn nhấp vào tùy chọn View, 

sau khi 1 flyout xuất hiện bạn nhấp vào tùy chọn Ruler (show ruler) để làm xuất 

hiện thước xung quanh màn hình làm việc của CorelDRAW. Để làm ẩn thước ta 

cũng thực hiện các bước tương tự. Thước có tác dụng trong việc giúp bạn xác định 

kích thước cũng như đơn vị đo của đối tượng trong bản thiết kế 
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1.2.2 Lưới – Grid 

Lưới có tác dụng trong việc bạn thiết kế hay muốn sắp xếp các đối tượng theo 

một đơn vị tỷ lệ nhất định, ở đây lưới được hiển thị như một bảng kẻ ô vuông 

với các đường dọc và ngang đan nhau. Bạn có thể tùy chọn hiển thị hay che 

khuất lưới bằng cách nhấp vào tùy chọn View trên thanh thực đơn (menu), sau 

khi flyout hiện ra bạn nhấp tiếp vào tùy chọn Grid, ngay lập tức lưới sẽ xuất 

hiện trên màn hình làm việc của phần mềm. để che khuất lưới ta cũng có các 

bước làm tương tự. 
 

1.2.3 Đường gióng kích thước 

Đường gióng kích thước là một công cụ hỗ trợ cho bạn trong việc căn chỉnh một 

cách chi tiết vị trí của các đối tượng theo chiều thẳng đứng và nằm ngang, nó cũng hỗ 

trợ bạn trong việc “nắn” thẳng các đường mà bạn tạo ra một cách tự do. Để làm xuất 

hiện các đường going kích thước, bạn cần chọn menu View trên thanh thực đơn, sau 

đó nhấp vào tùy chọn Guidelines trong flyout xuất hiện sau đó. Đường gióng kích 

thước hiển thị trên màn hình làm việc dưới dạng các đường nét đứt, đường mà bạn tạo 

ra sau cùng và đang sử dụng sẽ có màu đỏ. Để tạo ra các đường gióng bạn cần làm 

hiển thị thước, sau đó nhấn giữ và kéo con chuột chọn từ thước ra vị trí bạn muốn 

gióng. Muốn tạo ra các đường gióng theo chiều thẳng đứng bạn kéo từ trái qua, muốn 
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tạo ra các đường going theo chiều nằm ngang bạn kéo từ trên xuống. Nếu bạn muốn bỏ 

bớt đường gióng nào thì nhấp chuột vào đường gióng đó sau đó nhấn phím Xóa – 

delete trên bàn phím. Nếu không muốn hiển thị đường gióng bạn làm quy trình tương 

tự như khi muốn làm hiển thị nó. 
 

2. Hộp công cụ của Draw 

2.1 Công cụ chọn 

Công cụ chọn đối tượng (Pick Tool) không trực tiếp tạo ra các hình dạng cho đối 

tượng nhưng nó rất cần thiết và sử dụng rất nhiều trong quá trình vẽ. 

- Chọn đối tượng: 

Muốn chọn một đối tượng, chọn Pick Tool click chuột lên đối tượng hay đường viền 

của nó. Đối tượng được chọn sẽ xuất hiện 8 ô vuông màu đen xung quanh gọi là các 

điểm điều khiển, dấu gạch chéo ở giữa là tâm đối tượng 

Khi đối tượng được chọn, các thông tin sẽ được thể hiện trên thanh trạng thái hay còn 

gọi là thanh thuộc tính 

- Chọn nhiều đối tượng: 

Cách 1: Để chọn nhiều đối tượng, ta nhấn giữ phím Shift và click chọn từng đối tượng 

và ngược lại giữ phím Shift chọn lại đối tượng đã được chọn là ta bỏ đối tượng đó. 

Cách 2: Click giữ và kéo chuột tạo vùng chọn bao quanh các đối tượng muốn chọn. 

- Di chuyển đối tượng: 

Muốn di chuyển đối tượng, nhấn giữ chuột kéo và di chuyển đến vị trí muốn đặt đối 

tượng rồi thả. 

- Quay đối tượng: Click chuột hai lần lên đối tượng, click chuột vào một trong bốn 

điểm xoay của đối tượng và kéo theo hướng muốn quay rồi thả chuột . 
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- Kéo xiên đối tượng: 

Click chuột hai lần lên đối tượng, click chuột vào một trong bốn điểm xoay của đối 

tượng và kéo theo hướng muốn quay rồi thả chuột. 

Giống như quay đối tượng nhưng click chuột vào một trong bốn vị trí kéo xiên (hình 

hai đầu mũi tên). Muốn đối tượng xiên về hướng nào thì kéo về hướng đó 
 

 

- Thay đổi kích thước của đối tượng: 

Chọn đối tượng, click vào một trong 8 handle màu đen xung quanh đối tượng, kéo 

chuột về gần tâm hay xa tâm rồi thả để thu nhỏ hay phóng to đối tượng. 

- Xóa đối tượng: 

Để xóa một hay nhiều đối tượng, chọn một hay nhiều đối tượng và nhấn phím Delete 

để xóa. 

2.2 Công cụ định dạng 

Shape tool: Ví dụ bạn vẽ một hình chữ nhật trên trang giấy bằng công cụ Rectangle ( 

lúc này xung quanh hình chữ nhật xuất hiện 8 tay nắm và một tâm quay ở giữa, bạn 

click chọn công cụ Shape, khi chọn xong hình chữ nhật mà bạn đã tạo ra có hình dạng 

như sau: 
 

 

 

- Di chuyển con trỏ chuột đến 1 đỉnh của hình chữ nhật, nhấn giữ chuột trái và kéo để 

bo tròn các đỉnh, khi đã vừa ý bạn thả nút chuột: 
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Trong trường hợp bạn muốn biến đổi một hình elip, bạn có thể tạo ra 1 hình elip bằng 

công cụ Elipse. Sau khi bạn nhấp vào công cụ Shape bạn sẽ thấy xung quanh hình elip 

có đường bao nét đứt và có 1 nút nhỏ 
 

 

 

- Di chuyển con trỏ chuột tới nút nhỏ này và kéo rê con chuột vào bên trong hình elip, 

bạn sẽ thấy hình hình của bạn biến thành hình quạt: 
 

 

 

Trong trường hợp bạn muốn biến đổi một hình đa giác, bạn có thể tạo ra hình đa giác 

có 5 cạnh bằng cách sử dụng công cụ Polygon. Bạn nhấp chọn công cụ Shape: 
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- Di chuyển con trỏ chuột tới 1 tay nắm và kéo vào trong, ta sẽ thấy hình đa giác biến 

đổi như sau: 

 

 

 

- Di chuyển con trỏ chuột tới 1 tay nắm và kéo ra ngoài, ta sẽ thấy hình đa giác biến 

đổi như sau: 
 

 

 

 

Bằng cách thay đổi hướng di chuyển của con trỏ chuột theo các hướng khác nhau bạn 

sẽ tạo ra các hình đa giác tùy thích. 

2.3 Công cụ bút chì 

Công cụ Freehand thực hiện vẽ tương 

tự như vẽ bằng một cây bút thật. Công 

cụ này có thể tạo ra các đường cong 

đóng, mở hay các đường thẳng. 

- Vẽ đường thẳng: nhấp chuột tại một 

điểm, di chuyển chuột (không giữ chuột) 

đến điểm kết thúc nhấp chuột tạo một 

đường thẳng. Để vẽ những đường thẳng 

liền nhau, nhấp đúp chuột tại điểm kết 

thúc của đường thẳng rồi tiếp tục nhấp 

chuột tạo đường thẳng nối tiếp. 

- Vẽ đường cong: nhấp giữ chuột kéo theo 

đường cong bạn muốn tạo rồi thả chuột để hoàn tất đường vẽ. Để tạo những vùng khép 

kín trong khi vẽ chỉ cần cho điểm đầu trùng với điểm cuối. 
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2.4 Công cụ hình chữ nhật 

 

 

 

 

 

 

Khi rê chuột lên đối tượng, con trỏ chuột của công cụ sẽ cho biết 

thông tin của đối tượng như node, tâm (center) điểm giữa 

(midpoint), cạnh (edge). 

Khi vẽ hình chữ nhật xong, thanh thuộc tính sẽ cho biết thông tin 

của hình chữ nhật (kích thước: chiều rộng và chiều cao; đường 

viền. 

Để vẽ hình chữ nhật từ tâm ra, nhấn Shift và kéo chuột ra. 

Để vẽ hình vuông nhấn Ctrl và kéo chuột ra. Để vẽ hình vuông hướng từ tâm ra nhấn 

tổ hợp phím Ctrl + Shift và kéo chuột. 
 

Để thay kích thước cho hình chữ nhật, trên thanh thuộc tính ở ô Object(s) Size nhập 

kích thước ta có được một hình chữ nhật mới. 

Trong ô Left Rectangle Corner Roundness hay ô Right 

Rectangle Corner Roundness để làm bo tròn 4 góc của hình 

chữ nhật. 

Biểu tượng Round Corners Together nổi lên với hình ổ khóa 

cho phép thực hiện bo tròn từng góc và ngược lại thực hiện bo 

tròn bốn góc cùng một lúc nhưng giá trị chỉ cần nhập vào một ô. 

Click chuột vào mũi tên chỉ ngược của ô Outline Width để
 

chọn độ dày đường viền. 

Công cụ 3 Poin Rectangle Tool 

Để chọn công cụ 3 Poin Rectangle Tool, ta click vào tam giác màu đen góc phải bên 

dưới công cụ Rectangle Tool và chọn công cụ 3 Poin Rectangle Tool. Lúc này con trỏ 

chuột có hình dấu cộng giống như công cụ Rectangle Tool nhưng hình chữ nhật bên 

dưới khác một chút (hai cạnh trên là nét đứt khúc, còn hai cạnh dưới là nét liền). 
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Để vẽ hình chữ nhật bằng công cụ 3 Poin Rectangle Tool ta thực hiện các bước sau: 

Nhấp giữ chuột kéo theo hướng muốn vẽ, thả chuột, rê chuột sang hướng khác sao cho 

tạo được hình chữ nhật và nhấp chuột kết thúc. 

 

 

Để vẽ hình vuông, nhấn phím Ctrl và kéo chuột.Để thay đổi những thuộc tính cho hình 

chữ nhật vẽ bằng công cụ này cũng giống như vẽ bằng công cụ Rectangle Tool. 

2.5 Công cụ văn bản 

Giúp trình bày văn bản có thể một doạn văn bản hoặc một trang văn bản , phủ văn bản 

xung quanh đối tượng dồ họa, đưa chữ lên trên một đường path. Cách thực hiện như 

sau: 

1. Nhập Đoạn Văn Bản 

(công cụ tạo văn bản).cho phép nhập theo chiều ngang hay chiều dọc tùy theo ý 

muốn mục đích cùa bạn. 

1 - Cách nhập 1 dòng văn bản , chọn công cụ (text tool) 

click trái lên màn hình/ nhả chuột / nhập văn bẵn lên 

màn hình 

2 - Nhập trang văn bản / chọn công cụ(A) / click trái kéo để để tạo khung trang 

3 - Thay đổi font chữ - chọn Font chữ . mục: Font click -trên thanh Property 

- Mục Size- Kích thước chữ , Mục :B .Chữ nét đậm, Mục I- chữ nét xiên, Mục U.- 

Kiểu chữ gạch chân. 

- Đối với văn bản mục :Align canh lề văn bản . Left : Canh lề trái; Right: Canh lề 

phải; Center : Canh giữa; Force Full: Canh đều 2 đầu . 
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3. Công cụ đường viền và tô màu 

3.1 Công cụ đường viền 

Công cụ này xác định các thuộc tính cho đường biên về màu sắc, độ dày, kiểu đường 

biên cho đối tượng. 

Chọn Outline Tool, những tùy chọn trải ra. 

Chọn Outline Pen Dialog hộp thoại Outline Pen được mở ra, trong này chứa những 

thuộc tính đầy đủ nhất về đường biên như màu sắc, kiểu đường biên. 
 

 

Color: chọn màu cho đường biên. 

Width: độ dày của đường biên. 

Style: kiểu thể hiện đường biên (đứt nét, đường liền, v.v...). 
 

 

Edit Style mở hộp thoại Edit Line Style: tạo những kiểu đường viền mới. 

Corners: các kiểu thể hiện góc của đường path. 

Line caps: thể hiện đầu của đường mở. 

Arrows: thực hiện những lựa chọn tạo mũi tên cho điểm đầu hoặc cuối của đối tượng. 
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Calligraphy: với những chọn lựa như Nib Shape (kiểu đầu bút), Stretch (thay đổi chiều 

dài nét bút), Angle (quay đầu bút) thực hiện hiệu ứng thay đổi chiều dày nét tùy theo 

hướng của đường làm cho những nét vẽ như vẽ bằng bút sắt có đầu bị vát. 

3.2 Công cụ tô màu nền 

Hộp thoại Pattern Fill Dialog thực hiện tô màu đối tượng theo mẫu tô có sẵn tạo nên 

một nền. 

 Chọn đối tượng tô bằng công cụ Pick Tool. 

 Chọn công cụ Pattern Fill Dialog trong thanh ToolBox. 
 

 Hộp thoại Pattern Fill hiển thị, trong hộp thoại bạn có tùy chọn 3 kiểu tô. 
 

 

 2-color: tô theo mẫu được tạo bằng những hình hoa văn với hai màu, một cho 

màu nền và một cho những hoa văn trên bề mặt. 

Khi bạn chọn mịc 2-color: 
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 Front : chọn màu cho bề mặt. 

 Back  : chọn màu tô cho nền. 

 Click chọn vào ô: 
 

để mở danh sách và chọn kiểu vân nền. 
 

 Nhấn vào nút Load để mở hộp thoại Import và chọn một tập tin hình ảnh 

cần để tạo nền. Mẫu mới sẽ được hiển thị đưa vào danh sách. 

 Nhấn Delete để xoá mẫu vân nền bạn đang chọn. Hộp thoại Delete Two- 

Color Pattern hiển thị, bạn click chọn OK để chấp nhận xoá . 

 Create: giúp bạn tạo ra một mẫu riêng. Khi nhấn chọn Create, bảng Two- 

Color Pattern Editor hiển thị với những tùy chọn: 
 

 Bitmap size: chọn kích thước hiển thị để bạn vẽ tạo hình vân nền (có 3 

kích thước thiết lập sẵn). 

 Pen size: độ dày của bút vẽ (có 4 độ dày được thiết lập) 

 Bạn click chuột vào ô lưới để vẽ tương tự như trên bản vẽ. 
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 Vẽ xong, nếu vừa ý bạn click chọn nút OK để chấp nhận. 
 

 

 

 Full color: tô màu đối tượng bằng những mẫu đầy hoa văn và hình dạng với 

nhiều màu sắc khác nhau. 
 

 Click chọn vào ô: 
 

một danh sách mẫu hiện ra, bạn click chọn 

một mẫu thích hợp. 

 

 

 

 Để đưa hình vào tạo vân mẫu, bạn click chọn 

Load (thực hiện tương tự như Two-color). 

 Xoá một mẫu bạn tạo, click chọn mẫu và nhấn 

nút Delete. 
 

 

 Bitmap: tô đối đượng theo mẫu là những hình ảnh. 

 Click chọn mẫu hình ảnh vào ô: 
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một danh sách ảnh hiện ra, bạn click chọn một ảnh cần thiết để làm nền 

tô. 
 

 Nếu muốn đưa ảnh từ ngoài vào, bạn click chọn nút Load. 

 Muốn xóa ảnh bạn load từ ngoài vào, bạn chọn ảnh trong danh sách và click 

nút Delete. 
 

 

 Origin: xác định vị trí bắt đầu của mẫu tô với hai ô x, y. 
 

 Size: xác định khoảng cách các vân của mẫu tô với hai ô Width (chiều rộng), 

Height (chiều cao). 
 

 Transform: nhập giá trị góc kéo xiên và góc quay cho các đối tượng trong ảnh 

với hai ô Skew và Rotate. 
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 Row or column offset: chỉ định hoa văn ảnh lệt theo cột (column) hay theo 

dòng (Row). Nhập độ phần trăm lệch trong ô . 

 

 Khi chọn mục Transform fill with object khi thực hiện biến dạng các đối 

tượng thì nền tô thay đổi theo. 
 

 Khi chọn mục Mirror Fill làm những mẫu tô sẽ xếp lớp đối xứng trong nền tô. 
 

4. Quản lý tập tin 

4.1 Mở và lưu tệp tin 

 File > Open > Chọn File cần mở. 

 File > Export > thiết lập các định dạng cho file xuất. 
 

• Save in: Xác định đường dẫn chứa file xuất. 

• File name: Nhập tên file. 

• File of type: Chọn định dạng cho file cần xuất (*.Jpg, *. TIFF, *. Gif,…). 

• Selected only: Chỉ xuất các đối tượng được chọn. 

 

4.2 Nhập và xuất tệp tin 

File > Import (Ctrl+I) 

Nhập các file dữ liệu vào tài liệu hiện hành. (Đối với các file hình ảnh phải sử dụng 

lệnh Import, Corel không cho phép Open các file ảnh bitmap). 

• Look in: xác định đường dẫn chứa file đã lưu. 

• Double click vào file cần nhập. 

File > Export (Ctrl+E) 

Xuất file sang các định dạng khác. Corel có thể xuất sang nhiều định dạng chuẩn khác 

nhau (*.TIFF, *.JPG, *.Gif,...). 

Ví dụ: 

Xuất file Corel (*.Cdr) sang định dạng Bitmap để có thể chỉnh sửa trong phần mềm 

Photoshop. 
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4.3 In ảnh 

Tại cửa sổ đang thực hiện chọn Print 
 

 

Hộp thoại Print xuất hiện. Tùy chỉnh các thông số phù hợp. 
 

 

Chọn vị trí ảnh hiện trên trang in. 
 

 

 

Chọn size hình ảnh trên trang in 
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Chọn số lượng trang cần in. 
 

 

 

Hoàn tất các tùy chỉnh và chọn in bằng nút Print. 
 

5. Công cụ Hỗ trợ thiết kế 

5.1 Thiết lập chế độ quan sát 

Có nhiều tính năng trong CorelDRAW12, một số cũ, một số mới mà nhiều 

người dùng không sử dụng. Một số trong số đó là rất hữu ích và quan điểm Docker là 

một trong những ví dụ đá quý hiếm khi được sử dụng. Với nó, bạn có thể đánh dấu vị 

trí của bạn bao gồm các trang và mức độ phóng. Bắt đầu bằng cách nhấn Ctrl + F2 để 

mở Xem đốc Docker (Window | Dockers | Xem Manager ...) 



28  

 

 

 

 

 

Các CorelDRAW Xem Manager cho phép bạn "đánh dấu" xem không gian làm 

việc hiện tại của bạn 

Một "điểm" theo người quản lý xem là vị trí hiện tại bạn đang ở trong một tài 

liệu, và mức độ zoom. Với một tập tin mở, bạn có thể lưu quan điểm và dễ dàng 

chuyển giữa chúng bằng cách sử dụng quản lý xem. Nhấp vào nút "+" để đánh dấu vị 

trí và mức độ phóng hiện hành. Bạn có thể cho nó một cái tên bằng cách kích chuột 

vào xem trong bộ quản lý xem và chọn "đổi tên" từ menu hiện ra. 

Ví dụ này thêm một số quan điểm, đảm bảo bạn phóng to hoặc thay đổi trang 

đầu để mỗi lần xem là khác nhau. Ở đây tôi đang làm việc trên một tấm áp phích với 

một số doanh nghiệp nhỏ A3. Tôi đã được lưu trữ một cái nhìn đầy đủ trang tại 100% 

zoom, và cũng là một cận trên diện tích-chi tiết cao. Tôi có thể chuyển giữa các điểm 

chi tiết để chỉnh sửa, và xem trang đầy đủ để xem như thế nào chỉnh sửa tôi đã làm ảnh 
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hưởng đến hình ảnh hấp dẫn của người gửi tổng thể. Bạn cũng có thể đánh dấu quan 

điểm về các trang khác nhau. Để trở về một điểm đánh dấu, chỉ cần nhấp một lần vào 

nó. 
 

 

 

Bạn có thể kích hoạt hoặc vô hiệu hóa trang của xem và / hoặc mức độ phóng. 

Các biểu tượng trang và kính lúp bên cạnh tên của mỗi thiết bị chuyển mạch 

chuyển đổi xem có thể được kích hoạt hoặc vô hiệu hóa bằng cách nhấp vào chúng. 

Với biểu tượng kính lúp bị vô hiệu hóa, chỉ có trang sẽ thay đổi, không phải là mức độ 

phóng. Với các biểu tượng trang bị vô hiệu hóa, chỉ có mức độ phóng sẽ thay đổi. Nếu 

bạn có cả người khuyết tật, xem đó là vô hiệu hóa một cách hiệu quả. 

Đây là một tính năng hữu ích, bởi vì bạn có thể có nhiều thiết kế cho một dự án 

trên các trang cá nhân trong một tài liệu. Bạn có thể gọi là một quan điểm "khái niệm 

1, chi tiết logo" và một "khái niệm 2, cơ thể văn bản". Đôi khi bạn có thể muốn chuyển 

sang mức độ phóng của "khái niệm 2, cơ thể văn bản" trong khi ở trên trang hiện tại. 

Mặc dù phải mất một chút cưỡng bức nhận được sử dụng trước khi bạn tự nhiên 

sử dụng các Xem quản lý trong các thiết kế hàng ngày của bạn, nó chắc chắn sẽ trả 

hết. Một chuẩn bị ít cho mỗi tài liệu bạn đang làm việc trên sẽ làm cho điều hướng một 

chút hiệu quả hơn. 

5.2 Hỗ trợ thiết kế 

Khi mở một file mới, màn hình làm việc của CorelDRAW 12 xuất hiện một 

hình chữ nhật nằm trên màn hình đó chính là trang vẽ của Corel. Để xem thuộc tính 

và thiết lập thể hiện của trang vẽ, chọn File - Document Setup - Page Setup, hộp thoại 

Options mở ra. 
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- Show page border: đánh dấu tùy chọn này để thể hiện khung trang 
 

- Show printable area: đánh dấu tùy chọn này để vùng thông báo phạm vi máy in in 

được và kích thước trang giấy in 

- Show bleed area: vùng giúp tránh lỗi do có những chi tiết tràn ra ngoài biên của 

thành phẩm 

Mục Size: 
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- Biểu tượng Portrait và Landscape cho phép chọn hướng của trang đứng hay ngang 

- Paper: khổ của trang vẽ 

- Width và Height: cho biết chiều dài và rộng của trang vẽ, ứng với kiểu chọn khổ 

giấy của trang vẽ 

Mục Layout: có 6 kiểu trình bày trang vẽ, tùy vào mục đích sử dụng mà ta chọn kiểu 

trình bày tương ứng. 

- Full Page: kiểu bố trí trang mặc định (hình 4) 
 

- Book: chia trang thành hai phần bằng nhau theo chiều dọc. Mỗi phần là một trang 

riêng biệt được in thành hai trang 
 

- Booklet: tương tự như kiểu Book nhưng khi in các trang được ghép gáy lại với nhau 

để có thể đóng thành cuốn sách 
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- Tent Card: chia thành hai phần bằng nhau theo chiều ngang 
 

- Side Fold Card: chia trang thành bốn phần theo chiều ngang lẫn chiều dọc. Sau khi 

in sẽ được gấp theo chiều ngang trước rồi đến chiều dọc 
 

- Top Fold Card: giống như kiểu Side Fold Card nhưng gấp theo chiều dọc trước rồi 

đến chiều ngang 

Mục Background: có 3 tùy chọn 

- No Background: không hiển thị màu nền 

- Solid Background: Hiển thị màu nền là màu đồng nhất cho trang vẽ 

- Bitmap: sử dụng ảnh Bitmap làm nền cho trang vẽ 

Xem thông tin trang vẽ: Chọn File - Documents Info... 

Các thông tin về hiệu ứng, màu tô, kiểu chữ... được áp dụng trong bản vẽ đều thể hiện 

trong hộp thoại này. Bạn có thể xem một hay nhiều thông tin về File, Documents, 

graphics Objects... bằng cách chọn nó. Chọn Save As để lưu thông tin này dưới dạng 

văn bản. 
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6. Thực hành 

6.1 Thao tác các công cụ vẽ. 

Mở Coreldraw và thực hiện thao tác các công cụ vẽ như các hướng dẫn phía trên. 

6.2 Đổ đường viền và màu nền cho hình vẽ 
 

 Sử dụng công cụ Rectangle Tool (F6) vẽ hình vuông và tô màu xanh tím 

 Vẽ hình chữ nhật và nhập thông số góc bo 100 với góc trên bên trái và dưới bên 

trái 

 Sao chép đối tượng và xoay đối tượng với góc 90 độ 

 Sao chép đối tượng và xoay đối tượng với góc 45 độ 

 Xoay đối tượng 90 độ hoặc lật đối xứng đối tượng (theo chiều dọc và chiều 

ngang) 

 Vẽ hình tròn từ tâm với công cụ Ellipse Tool 

6.3 Vẽ biểu tượng Windown XP 

Bước 1: Vẽ phần bên trái của biểu tượng cửa sổ 

- Chọn công cụ vẽ hình chữ nhật (Rectangle Tool – F6 ) vẽ 1 hình chữ nhật đứng 

có kích thước chiều rộng bằng 2/3 chiều dài 

- Click chuột 2 lần vào hình chữ nhật, xung quanh hình chữ nhật xuất hiện các mũi tên, 

click chuột vào mũi tên trên cạnh chiều rộng rồi kéo sang phải 1 khoảng vừa phải 

- Chọn hình chữ nhật -> click chuột phải rồi chọn Convert to Curves 
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- Chọn công cụ chỉnh node (Shape Tool – F10 ) 

 

- Click chọn cạnh chiều rộng, trên thanh thuộc tính của công 

cụ Shape Tool chọn ôConvert Line to Curve  rồi tạo hình vòng 

cung cho các cạnh 

- Copy hình vừa tạo và nhân lên làm 4 bản 

- Tô màu hai hình bằng màu xám, 1 hình màu đỏ, 1 hình màu xanh 

da trời, hình còn lại sử dụng ở bước 2 

Bước 2: Vẽ phần bên phải của biểu tượng cửa sổ 

- Click chuột 2 lần vào 1 hình chưa được tô màu ở bước 1, ở bốn góc của hình xuất 

hiện hình mũi tên xoay vòng, click chuột và xoay hình 1800 ta được 1 hình mới ngược 

với các hình ở trên 
 

- Copy hình vừa tạo và nhân lên làm 3 bản 

- Tô màu 2 hình bằng màu xám, 1 hình màu xanh lá cây, 1 hình màu vàng 

Bước 3: Tạo bóng sáng cho cách hình 

- Chọn hình hình được tô màu đỏ rồi chọn công cụ Interactive Transparency Tool  

 

- Click chuột và kéo 1 đường lên trên hình, 1 biểu tượng mới 

xuất hiện với 1 đầu có hình vuông màu đen (gọi là gốc), 1 đầu 

mũi tên có hình vuông màu trắng (gọi là ngọn), ở giữa có 1 

thanh ngang để chỉnh mức độ sáng 

- Trên thanh thuộc tính trong ô Transparency Type chọn 

Radial 

 

- Click chuột và kéo phần gốc màu đen xuống góc phải bên dưới của hình, phần ngọn 

màu trắng lên góc trái phía trên của hình, kéo thanh ngang để có độ sáng phù hợp 

 

- Làm tương tự cho 3 hình màu xanh lá cây (gốc ở góc trái bên dưới, ngọn ở góc phải 

phía trên), xanh da trời (gốc ở góc phải phía trên, ngọn ở góc trái phía dưới), và màu 

vàng (gốc ở góc trái phía trên, ngọn ở góc phải phía dưới) 

Bước 4: Ghép hình 

- Di chuyển các hình đến vị trí phù hợp để tạo 1 hình giống như hình cửa sổ 
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- Trong quá trình sắp xếp các hình có thể chồng lên nhau không theo ý muốn, bạn có 

thể chọn các hình màu xám, click phải chuột, chọn Order rồi chọn To Back để hiển thị 

hình xuống phía dưới các hình được tô màu khác 

- Chọn tất cả các hình, click phải chuột rồi chọn Group để nhóm thành 1 hình 
 

Bước 5: Viết chữ 

- Chọn công cụ Text Tool F8  rồi viết lần lượt các chữ Windows, Microsoft, Xp, 

TM, R 

- Điều chỉnh kích cỡ chữ R thật nhỏ rồi vẽ 1 vòng tròn bao quanh, sau đó copy và nhân 

lên thêm 1 bản 

- Tô chữ XP bằng màu đỏ, các chữ còn lại tô màu đen 

- Chọn Font chữ và kích thước phù hợp cho các chữ. 

Bước 6: Hoàn thiện 

- Di chuyển các biểu tượng, các chữ đến các vị trí thích hợp 

- Chọn tất cả các hình, các chữ, click phải chuột rồi chọn Group để nhóm lại thành 1 

hình duy nhất 
 

6.4 Vẽ logo 

Mở 1 file mới 

Dùng công cụ Ellipse Tool vẽ 1 đường tròn 
 

Vẽ hạt lúa rồi vào Fill Tool>Fountain Fill để tô màu cho hạt lúa 
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Coppy ra nhiều hạt lúa rồi xắp xếp chúng như hình dưới và bỏ viền hạt lúa 
 

Nhóm bông lúa lại rồi coppy lật đối xứng, xóa hình tròn đi, thêm text vẽ hình tròn to 

rồi tô màu 
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7. Kiểm tra 

7.1 Bài 1 
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7.2 Bài 2 
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7.3 Bài 3 

Thực hiện các logo 
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Mục tiêu : 

BÀI 2 : THIẾT KẾ NÂNG CAO 

Mã bài MĐ18-02 

Trình bày được trình tự áp dụng các hiệu ứng; 

Vận dụng thành thạo vào thiết kế các ảnh vector; 

Hình thành ý thức lao động là phải khẩn trương có kỷ luật, có trách nhiệm và sáng 

tạo. 

1. Hiệu ứng cơ bản 1 

1.1 Cửa sổ cuốn Transfrom Roll-up 

Lệnh hiệu chỉnh dùng để dịch chuyển, xoay, lật, co giãn, thay đổi kích thước và kéo 

nghiêng đối tượng một cách chính xác bằng cách nhập số. 

a. Dịch chuyển – Position:- Vẽ một đối tượng tự do- Chọn đối tượng bằng công cụ 

chọn –pick tool- Chọn thực đơn Arrange -> Transformation -> Position 
 

 

Lúc này bạn sẽ thấy bên phải màn hình làm việc của bạn xuất hiện một hộp thoại. 

- Nhập kích thước muốn thay đổi vào hộp thoại H hoặc V 

- Click Apply hoặc Apply to Duplicate để thực hiện lệnh dịch chuyển cho đối tượng: 

o H = Horizontal: di chuyển chiều dọc 

o V = Vertical: di chuyển chiều ngang 

o Apply: thực hiện lệnh di chuyển không sao chép 

o Apply to Duplicate: thực hiện lệnh dịch chuyển nhưng sao chép đối tượng, đối tượng 

gốc vẫn giữ nguyên 

o Relative Position: xác định hướng dịch chuyển cho đối tượng 
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b. Xoay đối tượng – Rotation: xoay đối tượng quanh tâm xoay 

- Vẽ một đối tượng quanh tâm xoay 

- Chọn đối tượng với Pick tool 

- Chọn thực đơn Arrange -> Transformation -> Rotation 

- Nhập thông số vào hộp thoại Angle 

- Click Apply hoặc Apply to Duplicate để thực hiện lệnh xoay đối tượng 

o Angle: góc xoay 

o Center: tâm xoay 
 

 

 

c. Co giãn và lật – Scale and Mirror: co giãn đôi tượng theo tỷ lệ % 
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- Vẽ một đối tượng tự do 

- Chọn đối tượng với Pick tool 

- Chọn thực đơn Arrange -> Transformation -> Scale 

- Nhập kích thước muốn thay đổi vào hộp thoại Scale với H và V 

- Click Apply hoặc Apply to Duplicate để thực hiện lệnh 

o H – Horizontal: chiều ngang 

o V – Vertical: chiều dọc 
 

 

 

d. Thay đổi kích thước – Size: theo chiều ngang hoặc chiều dọc 

- Vẽ một đối tượng tự do 

- Chọn đối tượng với Pick tool 

- Chọn thực đơn Arrange -> Transformation -> Size 

- Nhập kích thước muốn thay đổi vào hộp H hoặc V 

- Click Apply hoặc Apply to Duplicate để thực hiện lệnh 

o H – Horizontal: chiều ngang 

o V – Vertical: chiều dọc 
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Công cụ biến dạng theo khung 

 

 

e. Kéo xiên – Skew: định góc xiên cho đối tượng tính theo độ (00) 

- Vẽ một đối tượng tự do 

- Chọn đối tượng với Pick tool 

- Chọn thực đơn Arrange -> Transformation -> Skew 

- Nhập kích thước muốn thay đổi vào hộp H hoặc V 

- Click Apply hoặc Apply to Duplicate để thực hiện lệnh 

1.2 Các hình bao 

Thực hiện như sau: 
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Chức năng tạo đối tượng theo đường bao 

 

Cách sử dụng 

- Tạo 1 đoạn văn bản / vào menu / effect / Envelope –xuất hiện hộp thoại 

- Mục : Addnew : tạo 1 mẫu đường bao mới 

- Mục kiểu khung bao tạo sẵn 

- Mục kiểu khung bao kết hợp vẽ tự do 

- Mục Addpreset; Thư viện mãu đường bao 

- Mục keep line ; 
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1.3 Chuyển tiếp giữa các đối tượng trung gian 

Bạn có thể thay đổi thứ tự xếp chồng của các đối tượng trong cùng một lớp. Trước khi 

sử dụng bất cứ lệnh nào bạn cần phải chọn đối tượng mà bạn muốn thay đổi thứ tự 

bằng công cụ chọn – pick tool. 

- Chọn đối tượng cần thay đổi thứ tự 

- Chọn Menu Arrange -> Order 

• to Front (Shift + page up): đưa đối tượng lên lớp trên cùng 

• to back (Shift + page down): đưa đối tượng xuống lớp dưới cùng 

• Forward one (ctrl+PgUp): đưa đối tượng được chọn lên một lớp 

• Back one (ctrl+PgDn): đưa đối tượng được chọn xuống một lớp 

• In front of: đưa đối tượng được chọn lên trước một đối tượng cụ thể, bạn click mũi 

tên màu đen xuất hiện sau đó vào đối tượng muốn nằm đè lên 

• Behind: đưa đối tượng được chọn xuống dưới một đối tượng cụ thể bất kỳ bằng cách 

click mũi tên màu đen vào đối tượng bạn muốn nằm bên dưới nó. 

• Reverser order: đảo thứ tự trên, dưới của các đối tượng trên cùng một lớp, muốn thực 

hiện lệnh này bạn cần phải chọn tất cả các đối tượng muốn thay đổi bằng công cụ 

chọn. 
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1.4 Tạo bóng đổ trên đối tượng 

Công cụ Interactive DropShadow Tool 

 Tạo một đối tượng và chọn đối tượng bằng công cụ Pick Tool. 

 Chọn công cụ Interactive Drop Shadow Tool trên thanh ToolBox. 
 

 Lúc này con trỏ chuột trên trang vẽ sẽ có hình dạng  

 Bạn click giữ chuột lên đối tượng và kéo, sau đó thả chuột để tạo bóng. 
 

 Hình vuông màu trắng trên đối tượng là tâm điều khiển gốc. 

 Hình vuông màu đen trên đối tượng là tâm điều khiển ngoài. 

 Thanh trượt sẽ thay đổi độ tăng mờ của bóng khi bạn kéo di chuyển. 

Bạn di chuyển các nút biểu tượng trên đối tượng để thay đổi kiểu hiển thị bóng. 

Chú ý: bạn không thể đổ bóng cho những đối tượng đã thực hiện những hiệu ứng 

như Blend,Contour, Extrude hoặc những đối tượng tạo bằng công cụ Artistic 

Media hoặc những đối tượng đổ bóng khác. 

 Thanh thuộc tính của Interactive Drop Shadow Tool hiển thị với 

các tùy chọn. 
 

 Presets List: chứa các kiểu bóng đổ do CorelDRAW 

thiết kế sẵn. Khi click chọn sẽ có một danh sách các kiểu hiển thị ra 

cho bạn chọn. 
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 Add Preset: thêm vào trong danh sách Presets List một kiểu hiệuứng do 

bạn tạo. 

 Delete Preset: xoá khỏi danh sách Presets List một kiểu hiệu ứng do bạn 

tạo. 

 Drop Shadow Offset: điều chỉnh vị trí của bóng so với đối tượng 

ban đầu (áp dụng cho việc đổ bóng từ tâm ra). Khi bạn thayđổi giá trị trong 

hai ô x và y thì vị trí của bóng sẽ thay đổi. 

 Drop   Shadow   Opacity:   thay đổi độ mờ của   bóng. 

Giá trịtrong ô thay đổi từ 0 đến 100. 
 

độ mờ với giá trị 16 độ mờ với giá trị 76 

 Drop Shadow Feathering: thay đổi độ mờ dần của bóng. 
 

giá trị là 8 giá trị là 27 

  Drop Shadow Feathering Direction: lựa chọn các kiểu hướng nhòe của 

biên bóng đổ. Khi click chọn, một danh sách hiển thị với các tùy chọn: 
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 Inside: hướng làm nhòe từ ngoài vào trong. 
 

 Middle: làm nhòe trung bình theo mỗi hướng. 
 

 Outside: hướng làm nhòe từ trong ra ngoài. 
 

 Average: chọn nhòe trung bình từ tâm ra. 
 

 Drop Shadow Feathering Edges: cho phép bạn chọn các 

hình thức thể hiện phần nhòe ở biên bóng đổ (biểu tượng này 

không được   kích   hoạt   khi   bạn   chọn   kiểu 

nhòe Average của Drop Shadow Feathering Direction). Khi 

click chuột sẽ có 4 tùy chọn hiển thị. 
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minh họa tuần tự cho 4 lựa chọn trên 

 Drop Shadow Color: thực hiện thay đổi màu cho bóng. 
 

 Copy Drop Shadow Properties: thực hiện sao chép thuộc tính đổbóng 

của một đối tượng này sang một đối tượng khác. 

 Tạo một đối tượng, chọn đối tượng bằng công cụ Pick Tool. 
 

  Chọn công cụ  Interactive Drop Shadow Tool, chọn tiếp biểu 

tượng Copy Drop Shadow Propertiestrên thanh thuộc tính. Lúc này 

con trỏ chuột sẽ hiển thịhình dạng , bạn click chuột vào phần bóng 

của đối tượng đã tạo bóng để thực hiện sao chép. 
 

Nếu bạn click chuột vào đối tượng thì không sao chép được. 
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  Clear Drop Shadow: xoá hiệu ứng đổ bóng của một đối tượng, đưađối 

tượng về trạng thái ban đầu. 

Tạo hiệu ứng bóng đổ dạng phối cảnh: 

Hiệu ứng bóng đổ dạng phối cảnh thực hiện đổ bóng từ trên xuống dưới, từ dưới lên 

trên, từ trái qua phải và ngược lại. 

Để thực hiện, bạn làm các thao tác như sau: 

 Nhấp chọn vào đối tượng. 
 

  Nhấp giữ chuột lên tâm điều khiển gốc  (hình vuông màu trắng), kéo và di 

chuyển tâm điều khiển gốc bắt dính vào tâm điều khiển ngoài và thả chuột ra. 
 

  Khi bạn thực hiện đổ bóng phối cảnh thì những tùy chọn như Drop 

Shadow Angle, Drop Shadow Stretch, Drop Shadow Fadetrên 

thanh thuộc tính sẽ được kích hoạt. 
 

  Drop Shadow Angle: thay đổi giá trị góc nghiêng của 

bóngđổ dạng phối cảnh. Giá trị thay đổi từ - 3600 đến 3600 
 

giá trị 36 giá trị - 34 

  Drop Shadow Fade: thay đổi độ mờ của bóng, phần bóng ở xađối 

tượng sẽ mờ hơn phần bóng ở gần đối tượng. Giá trị thay đổi tự0 đến 100 
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giá trị là 0 giá trị là 84 

  Drop Shadow Stretch: thay đổi độ trải dài của bóng. Giá trịthay đổi 

từ 0 đến 100 
 

giá trị là 50 giá trị là 89 

 

1.5 Tạo hình khối 3 chiều 

Mở file mới 

Dùng công cụ Text Tool để viết chữ 
 

Chọn công cụ Interactive Extrude Tool, click vào chữ rồi kéo ra, kết quả 
 

Vào Effects>Extrude chọn hiệu ứng Extrude light để tạo ánh sáng, kết quả 
 

Vào Fill Tool chọn công cụ Texture Fill Dialog để tô màu, kết quả: 
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2. Hiệu ứng cắt Power line - PowerClip – Lens 

2.1 Trang cửa sổ Preset 

Có một cách nhanh chóng để làm thanh công cụ bất kỳ biến mất hoặc hiện ra: bạn 

bấm-phải vào thanh công cụ nào đó và tùy ý bật/tắt các thanh công cụ được liệt kê trên 

trình đơn vừa hiện ra (hình 1). Bạn chú ý, phải "nhắm" vào bản thân thanh công cụ, 

đừng đụng nhầm vào các nút trên thanh công cụ. 

Hình 1 
 

Trình đơn xuất hiện do thao tác bấm-phải được gọi chung là trình đơn cảnh ứng 

(context-sensitive menu). Nghĩa là trình đơn "tương ứng với hoàn cảnh" í mà! Gọi như 

vậy là vì tùy theo bạn bấm-phải vào chi tiết nào trên màn hình, trình đơn hiện ra có các 

mục chọn liên quan đến chi tiết ấy. Trình đơn cảnh ứng liên kết với thao tác bấm-phải 

là phương tiện giao tiếp phổ biến trong Corel DRAW và trong môi trường Windows 

nói chung. 

Bạn thử ngay xem... 
 

Bấm-phải vào thanh công cụ Property 

Bar 
Trình đơn cảnh ứng hiện ra (hình 1) 
trình bày danh sách mọi thanh công cụ 

 

Nhìn vào trình đơn cảnh ứng vừa hiện ra, bạn để ý, trước mỗi tên gọi thanh công cụ 

có thể có dấu duyệt (check mark) hoặc không. Dấu duyệt ngụ ý nói rằng thanh công cụ 

tương ứng đang hiển thị trên màn hình. Muốn bật/tắt thanh công cụ nào, bạn bấm vào 

tên gọi của nó trên trình đơn cảnh ứng. 
 

Bấm vào Toolbox trên trình đơn cảnh 

ứng 

Thanh công cụ Toolbox biến mất 
 

Bấm-phải vào thanh công cụ Property Trình đơn cảnh ứng hiện ra. Lúc này 
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Bar trước tên Toolbox đã mất dấu duyệt vì 
thanh công cụ Toolbox ở trạng thái 

"tắt" 

Bấm vào Toolbox trên trình đơn cảnh 

ứng 
Thanh công cụ Toolbox hiện ra 

 

 

2.2 Lens Roll-up 

  Tạo hai đối tượng nằm lồng lên nhau, đối tượng nằm trên sẽ đóng vai 

trò là kính lọc. 

 Click chọn đối tượng nằm trên bằng công cụ chọn Pick Tool. 
 

 Click chọn menu lệnh Effects / Lens 
 

 Hộp thoại Lens hiển thị: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Click chọn vào ô sẽ có một danh sách hiệu ứng hiện ra. 
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Bạn lựa chọn hiệu ứng thích hợp. 

 

  Brighten: màu sắc nhìn qua đối tượng kính lọc sẽ sáng hơn hoặc tối hơn 

tùy theo giá trị nhập vào trong ô (giá trị cho phép trong 

khoảng -100đến 100) 
 

 

  Color Add: kiểu kính lọc cho phép giả lập màu của ánh sáng. Màu sắc 
nhìn qua đối tượng kính lọc Color Addsẽ được cộng thêm với màu được 

chọn trong ô Color  
 

 

 Color Limit: kính lọc cho kết quả ngược lại với Color Add. 
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  Custum Color Map: kính lọc này chuyển màu sắc cho đối tượng nằm 

dưới đối tượng kính lọc thành các màu trong dãy màu giữa hai màu được 

chọn trong hai ô và . Nút khi click sẽ hoán chuyển qua lại 

giữa hai màu đang chọn trong ô From và To. 
 

 

  Fish Eye: kính lọc thực hiện biến dạng đối tượng nằm dưới phóng to thu 

nhỏ đồng thời uốn cong. Bạn có thể thayđổi độ phóng to, làm đối tượng 

cong lên bằng cách thayđổi giá trị trong ô (giá trị từ - 

1000đến 1000) 
 

 

  Heat Map: làm cho màu sắc của đối tượng nằm dưới lạnh hơn hay nóng 
hơn   khi   nhìn   qua   kính   lọc.   Bạn   có thể thayđổi 

giá trị trong ô (giá trị thay đổi từ0 đến 100). 



56  

 

 

 Invert: đảo màu của những đối tượng nằm dưới. 
 

 

  Magnify: kính lọc làm cho đối tượng nằm dưới bị phóng to hay thu 

nhỏ đều. Giá trị phóng to hay thu nhỏ nhập 

trongô (giá trị trong khoảng từ 0.1 đến100). 
 

 

  Tinted Grayscale: chuyển màu của đối tượng nằm dưới sang màu đơn 

sắc. Bạn có thể thay đổi hiệu ứng màu trong ô . 
 

 

  Transparency: tạo hiệu ứng trong suốt giống công cụInteractive 

Transparency nhưng đơn giản hơn. Độtrong suốt được  hiệu  chỉnh 

trong ô vàhiệu ứng phối màu trong ô . 
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  Wireframe: kính lọc có tác dụng chuyển màu tô và đường biên của đối 

tượng phía sau thành một màu định sẵn.Outline và Fill chọn màu cho 

màu đường biên và màuđối tượng nằm dưới. 
 

Khi đối tượng nằm dưới không có đường biên thì các đường biên 

sẽkhông thể hiện qua kính lọc. 

 

  Frozen : tùy chọn này khi được chọn sẽ giữ lại kết quả hiệuứng 

không phụ thuộc vào đối tượng nằm dưới, nghĩa là khi hiệu chỉnh hay xoá đối 

tượng nằm dưới hoặc di chuyển đối tượng kính lọc sang vị trí khác, kết 

quả thể hiện trên kính lọc sẽ không thay đổi. 
 

không chọn Frozen có chọn Frozen 

 View Point: mặc định khi áp dụng hiệu ứng Lens tâm của đối tượng kính lọc 

chính là điểm nhìn (View Point). Tùy chọn View Pointđược chọn sẽ cho bạn thay đổi 

vị trí điểm nhìn và vị trí của đối tượng kính lọc độc lập nhau. Khi bạn nhấp chọn tùy 

chọn View Point, di chuyển vị trí kính lọc thì kính lọc vẫn giữ nguyên phần những 

thể hiện khi nhìn qua đối tượng tại vị trí ban đầu. 

Để thay đổi vị trí điểm nhìn. Chọn View Point, lúc này nút Edit hiển thị và trên 

kính lọc xuất hiện một nút gạch chéo Bạn click chọn vào nút Edit và nhập giá trịvào 
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các ô , định vị trí mới cho điểm nhìn hoặc bạn có thể kéo 

biểu tượng gạch chéo trên kính lọc để định vị trí mới cho điểm nhìn. 
 

 Remove Face: tùy chọn này được kích  hoạt ở một  vài  kiểu 

hiệu ứngLens (không áp dụng cho Fish Eye, Magnify) có tác dụng kiểm soát 

tác động của hiệu ứng Lens trên các vùng nền trang. Tùy chọn này được chọn 

hiệu ứng sẽ không tác động lên vùng nền trang. 

2.3 PowerClip 

 Tạo một vòng tròn, Import một hình ảnh vào trang vẽ. 
 

 Click chọn hình ảnh, chọn menu lệnh Effects / PowerClip / Place 

Inside Container 
 

 Lúc này trên trang vẽ con trỏ chuột sẽ có hình dạng  
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 Click chuột vào vòng tròn 
 

 Bạn sẽ được kết quả 
 

Bạn có thể tạo hiệu ứng PowerClip nhiều cấp, trong đó có nhiều đối tượng 

chứa lồng nhau. Mỗiđối tượng chứa của hiệu ứng PowerClip có thể có đối tượng nội 

dung riêng của nó. Các bước thực hiện hiệu ứng PowerClip nhiều cấp tương 

tự như một cấp. 

 

2. Hiệu chỉnh PowerClip: 

Khi thực hiện hiệu ứng PowerClip, đối tượng nội dung mặc định được đặt đồng 

tâm với đối tượng chứa. Tuy nhiên, bạn có thể hiệu chỉnh hoặc hủy tách rời hai hoặc 

nhiều đối tượng ra. 

 Dịch chuyển đối tượng PowerClip: 

 Bạn click chuột phải lên đối tượng PowerClip, chọn Edit Contents. 
 

 Đối tượng sẽ được tách ra, bạn click chuột lên đối tượng và dịch 

chuyển, sửa chữa theo ý muốn. 
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 Sau khi hiệu chỉnh xong, bạn click chuột phải lên đối tượng 

và chọnFinish Editing This Level. 
 

 Mở hoặc khóa nội dung vào đối tượng chứa: 

Thông thường theo mặc định thì đối tượng nội dụng sẽ bị khóa vào đối tượng 

chứa. Khi bạn thayđổi kích thước đối tượng chứa thì đối tượng nội dung sẽ thay đổi 

theo. 

Nếu bạn không muốn nội dung đối tượng thay đổi theo thì có thể bỏ chọn khóa 

bằng cách: 

 Click chuột phải lên đối tượng PowerClip, chọn Lock Contents To 

PowerClip (biểu tượng ổ khóa sẽ nổi lên - tức bạn đã bỏ chọn khóa) 
 

Khi bỏ chọn, nếu bạn thay đổi kích thước đối tượng chứa thì đối tượng 

nội dung sẽ giữ nguyên. 

 Xóa bỏ hiệu ứng PowerClip, tách nội dung đối tượng ra. 

Để xóa bỏ hiệu ứng PowerClip, bạn click chuột phải lên đối tượng 

và chọn Extract Contents. 
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3. Hiệu chỉnh nhóm đối tượng vẽ 

3.1 Sắp xếp các đối tượng vẽ 

Trong Corel, các đối tượng được tạo trước sẽ nằm bên dưới và bị che khuất bởi 

các đối tượng nằm phía trên nó. Các bạn có thể thay đổi thứ tự sắp xếp của các đối 

tượng bất cứ lúc nào bạn muốn. 

Thao tác thực hiện: 

1. Chọn các đối tượng cần thay đổi vị trí. 

2. Chọn menu Arrange > Order > chọn các lệnh phù hợp 
 

• To Front: Chuyển đối tượng lên trên cùng. 

• To Back: Chuyển đối tượng xuống dưới cùng. 

• Forward One: Chuyển đối tượng lên trên một lớp. 

• Back One: Chuyển các đối tượng xuống dưới 1 lớp. 

• In Front Of...: Chuyển các đối tượng lên trên đối tượng chỉ định. 

• Behind...: Chuyển các đối tượng xuống dưới đối tượng chỉ định. 

• Reverse Order: Thay đổi thứ tự của các đối tượng được chọn trên cùng 1 

Layer. 

 

Chú ý:Các lệnh sắp xếp vị trí chỉ có tác dụng đối với các đối tượng trên 

cùng 1 layer. 

3.2 Căn chỉnh các đỗi tượng vẽ. 

Để thực hiện việc canh giữa các đối tượng với nhau và giữa các đối tượng với 

trang vẽ, bạn sử dụng menu lệnh Arrange / Align and Distribute. 
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Để thực hiện các lệnh canh này, bạn cần phải chọn các đối tượng cần canh bằng 

công cụ chọn Pick Tool. 

Trong menu lệnh Align and Distribute chứa các lệnh thực hiện sau: 

 Align Left: canh đối tượng về phía trái đối tượng chuẩn. Bạn có thể sử 

dụng phím tắt là L 
 

 Align Right: canh đối tượng về phía phải đối tượng chuẩn. Phím tắt sử 

dụng là R 
 

 Align Top: canh đối tượng lên phía trên đỉnh của đối tượng chuẩn. Phím 

tắt sử dụng là T 
 

 Align Bottom: canh đối tượng xuống cạnh đáy của đối tượng chuẩn. 

Phím tắt sử dụng là B 
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 Align Centers Horizontally: canh đối tượng theo tâm của chiều ngang đối 

tượng chuẩn. Phím tắt sử dụng là E 
 

 Align Centers Vertically: canh đối tượng theo tâm của chiều đứng đối tượng 

chuẩn. Phím tắt sử dụng là C 

 Center To Page: canh tất cả các đối tượng được chọn vào giữa trang giấy vẽ. 

Phím tắt sử dụng là P 
 

 Center To Page Horizontally: canh các đối tượng theo tâm chiều ngang của 

trang giấy vẽ. 

 Center To Page Vertically: canh các đối tượng theo tâm chiều đứng của trang 

giấy vẽ. 

 Khi bạn click chọn vào mục Align and Distribute, hộp thoại Align and 

Distribute hiển thị gồm hai lớp Align và Distribute với các chức năng như đã được 

giới thiệu ở trên. 

 Lớp Align: 
 

 Lớp Distribute: 
 



64  

Khi bạn thực hiện chọn các giá trị trong hai lớp này xong, bạn click nút 

Apply để xem kết quả lựa chọn. Muốn thoát bạn nhấn vào nút Close để thoát khỏi 

hộp thoại. 

3.3 Nhân bản đối tượng 

Lệnh này tạo ra bản sao theo khoảng cách Offset mà bạn đã thiết lập. Khác với 

copy – paste, lệnh này không đặt bản sao đối tượng vào Clipboard Để sử dụng, bạn 

thao tác như sau: 

- Chọn đối tượng hoặc nhóm đối tượng. 

- Vào menu Edit > chọn Duplicate (Ctrl+D). Nếu đây là lần đầu tiên bạn sử 

dụng lệnh này thì hộp thoạiDuplicate Offset xuất hiện, bạn hãy nhập giá trị khoảng 

cách mặc định vào đây hoặc nhấn OK để bỏ qua. 
 

Về sau, khi cần thay đổi giá trị mặc định này, bạn có thể vào 

menu Tools > Options > Chọn mục Generaltrong danh sách xổ xuống 

của Document > thay đổi giá trị trong Duplicate Offset. 
 

Minh họa sử dụng lệnh Duplicate vẽ một cánh hoa: 

- Dùng công cụ Ellipse Tool vẽ một hình ellip 

- Nhấn chuột thêm một lần nữa lên hình này để hiện tâm và các điều khiển 

- Kéo tâm hình ellip xuống phía dưới 
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- Nhấn phím Ctrl và xoay hình 
 

- Giữ chuột trái, đồng thời nhấn chuột phải một lần để sao chép thêm một hình. 

- Nhấn tổ hợp phím Ctrl+D vài lần, ta sẽ có kết quả như sau: 
 

 

3.4 Các phép tính trên đối tượng vẽ. 

1. Lệnh Group: 

Lệnh Group dùng kết nhóm các đối tượng lại với nhau thành một khối chung. 

Ví dụ: bạn có các đối tượng rời rạc như minh học dưới đây: 
 

nếu muốn nhóm các đối tượng này lại, bạn chọn tất cả các đối tượng này 

bằng công cụ chọn Pick Tool. 
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tiếp theo click chọn vào menu lệnh Arrange / Group, các đối tượng sẽ 

nhóm lại thành một khối chung. 
 

 

2. Lệnh Ungroup: 

Lệnh Ungroup thực hiện tách riêng từng đối tượng trong nhóm. 

Ví dụ: bạn có các đối tượng đã được nhóm lại như sau: 
 

và bây giờ bạn cần tách chúng ra, bạn click chọn vào nhóm đối tượng cần 

tách. Chọn menu lệnh Arrange / Ungroup 
 

 

3. Lệnh Ungroup All: 

Tương tự như lệnh Ungroup nhưng thay vì tách riêng từng nhóm thì lệnh này 

có chức năng tách tất cả các nhóm trong bản vẽ thành những đối tượng riêng biệt 

nhau. 

Cách thực hiện tương tự như lệnh Ungroup. 
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4. Hiệu ứng 2 

4.1 Hiệu ứng Blen 

Sử dụng hiệu ứng Blens trên đối tượng như sau: 
 

 

 

 

 

 

 

 

 

 

1. Hòa trộn đối tượng . 

- Cách sử dụng : tạo và chọn 2 đối tượng / chọn công cụ : thanh Property : 

- Mục :Number of Step – định số bước chuyển 

 Mục: Blend Direction : xoay đoạn Blend , 

- Loop Blend : xoay theo dạng cong 

- Chuyển hai màu trực tiếp 

- Chuyển theo chiều kim đồng hồ 

2. Đưa đoạn blend lên trên đường path 

1) Chọn đoạn blend 
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2) Chọn mục: New Path 

3) Mục Blend Along Fulpath : dải đều lên đường path 

4) Mục Rotate All Object : xoay đoạn blend hướng vào đường path 

 giã đoạn Blend ra khỏi đường path : 

 Chọn đoạn Blend cần giã / vào menu / Arrange / Break Blend 
Apath 

- Ungroup All 

- Chuyển theo chiều ngược kim đồng hồ 

- Mục Object Color : tạo khoảng cách màu tô không đều nhau trong Blend 

- Mục Map Nodes : biến dạng đoạn Blend 

- Mục Plit : tạo 1 đối tượng di chuyển trong Blend. 

4.2 Hiệu ứng Contour 

 Chọn đối tượng bằng công cụ Pick Tool. 

 Chọn công cụ Interactive Contour Tool trên thanh ToolBox. 
 

 Lúc này trên trang vẽ, con trỏ chuột sẽ có hình dạng  

 Click chọn đường biên của đối tượng, nhấn giữ chuột và kéo chuột ra 

ngoài đối tượng để tạo bản sao và thả chuột ra. 
 

 Thanh thuộc tính của công cụ Interactive Contour hiển thị như sau: 
 

 Presets List: chứa danh sách kiểu Contour mặc định 

do CorelDRAW tạo sẵn. 
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 Add Preset: thêm một kiểu Contour do bạn tạo vào 

trong ô Presets List 

 Delete Preset: xoá một kiểu Contour do bạn tạo 

trongô Presets List. 

 To Center: chỉ những đối tượng Contour xuất hiện hướng vào 

trong về tâm của đối tượng gốc. 
 

 

 

 

gốc. 

 Inside: những đối tượng Contoure xuất hiện trong đối tượng gốc. 

 Outside: những đối tượng Contoure xuất hiện ngoài đối tượng 

 

 

 Contour Steps: xác định số đối tượng Countour. Bạn nhập 

giá trị vào ô để tăng hay giảm số đường Contour. 

 Contour Offset: xác định khoảng cách giữa các đối 

tượngContour. Nhập giá trị vào trong ô để thay đổi khoảng cách. 

 Linear Contour Colors: những màu của đối 

tượng Contourchuyển tiếp màu theo đường thẳng. 
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 Clickwise  Contour  Colors:  những  màu  của đối 

tượng Contourchuyển tiếp màu theo chiều kim đồng hồ dựa trên bánh xe màu 

chuẩn. 
 

  Counterclockwise Contour Colors: những màu của đối 

tượngContour chuyển tiếp ngược chiều kim đồng hồ dựa trên bánh xe màu 

chuẩn. 
 

  Outline Color: xác định màu đường biên của đối 

tượngContour cuối cùng. Màu đường biên của đối tượng Contour khác mang 

màu do sự chuyển tiếp màu đường biên giữa đối tượngContour cuối cùng và đối 

tượng gốc. Đối tượng gốc không tô màuđường biên thì đối tượng Contour không 

thể hiện đường biên. 

 Fill Color: Xác định màu tô cho Contour cuối cùng. Màu 

củađối tượng Contour khác chuyển tiếp giữa màu tô của đối tượngContour cuối 

cùng và đối tượng gốc. 

 End Fountain Fill Color: được kích hoạt khi đối tượng 

gốc được tô màu bằng công cụ Fountain Fill Dialog (F11). 

 Object and Color Acceleration: gia tăng hay giảm tốc độ biến 

màu và đối tượng giữa các đối tượng trong hiệu ứng Contour. 
 

 Bạn dịch chuyển thanh trượt để tăng hay 

giảm các đối tượng trong hiệu ứng Contour. 

 Bạn dịch chuyển thanh trượt để tăng hay 

giảm hiệu ứng chuyển màu giữa các đối tượng trongContour. 

 Nếu bạn nhấp chọn vào biểu tượng (biểu tượng được chìm 

xuống) thì khi bạn kéo một thanh trượt, thanh kia sẽ dịch chuyển tương xứng 

theo. 
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 Copy Contour Properties: sao chép thuộc tính của một đối 

tượngContour này sang đối tượng khác. 

 Tạo một đối tượng, và chọn đối tượng bằng công cụ chọnPick 

Tool. 
 

 Click chọn công cụ Interactive Contour Tool, con trỏchuột 

sẽ hiển thị thành hình dạng 

 Click chọn vào biểu tượng Copy Contour Propertiestrên 

thanh thuộc tính, con trỏ chuột sẽ hiển thị thành hình dạng . 

 Bạn click chọn vào đối tượng Contour để thực hiện sao chép. 
 

 Clear Contour: xoá bỏ hiệu ứng Contour cho một đối 

tượng, đưađối tượng trở về trạng thái ban đầu. 

 

Tách Contour khổi đối tượng ban đầu: 

 Chọn đối tượng Contour bằng công cụ Pick Tool. 
 

 Click chọn menu lệnh Arrange / Break Contour Group Apart. 
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 Click chuột ra ngoài trang vẽ, chọn vào đối tượng lần nữa và kéo đối 

tượng ra ngoài. 
 

 Click chọn vào đối tượng, chọn Arrange / Ungroup. Kéo tách rời 

từng đối tượng. 
 

 

4.3 Hiệu ứng Transparency 

 Tạo và chọn đối tượng cần thực hiện bằng công cụ Pick Tool. 

 Chọn công cụ Interactive Transparency Tool trên ToolBox 
 

 Lúc này trên trang vẽ, con trỏ chuột sẽ hiển thị thành hình dạng  

 Bạn click giữ chuột lên đối tượng và kéo theo các hướng bạn cần, 

thả chuột ra đểthực hiện tạo hiệu ứng. 
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 Biểu tượng : điểm điều khiển xác định vị trí trong suốt. 

 Biểu tượng : điểm điều khiển xác định vị trí không trong suốt. 

 Biểu tượng : điểm điều khiển vị trí mức độ trong suốt. 

 Đường thẳng đứt khúc nối giữa hai điểm và là đường định 

hướng. 

Bạn có thể nhấp chọn vào các biểu tượng trên đối tượng đã thực 

hiệnTransparency để hiệu chỉnh kiểu hiệu ứng. 

 Thanh thuộc tính chuẩn của công cụ Interactive Transparency 

Tool hiển thịvới các tùy chọn sau: 
 

  Edit Transparency: khi bạn nhấp chọn, hộp thoại Fountain 

Transparency hiển thị tương ứng với kiểu hiệu ứng trong suốt đangáp dụng 

cho đối tượng 
 

Bạn lựa chọn, thay đổi kiểu màu hiệu ứnh thích hợp trong  hộp 

thoại Fountain Transparency (hộp thoại này bạn đã học trong bài công 

cụ Fountain Fill Dialog - bạn nên xem lại). 

  Transparency Type: lựa chọn các kiểu thực hiện 

trong suốt cho đối tượng. Mỗi một kiểu lựa chọn thanh thuộc tính sẽhiển thị khác 

nhau. (các kiểu Transparency Type bạn tham khảo thêm cuối bài) 

 Transaprency Operation: chọn kiểu trộn màu giữa đối 

tượng áp dụng hiệu ứng trong suốt với đối tượng nằm bên dưới nó.Ví dụ các kiểu 

trộn như: 
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Normal Subtrac Difference 

  Transparency Midpoint: điều chỉnh độ trong suốt 

giữa hai điểm điều khiển. Bạn có thể kéo thanh trượt để thay đổi hoặc nhập 

lại giá trị trong ô  
 

giá trị là 100 giá trị 56 

 Fountain  Transparency  Angle  and 
Edge Pad: ô  thay đổi giá trị góc của đường định hướng (kiểu 

Radialkhông có lựa chọn này). Ô thay đổi khoảng cách giữa hai 
điểm điều khiển, giá trị thay đổi trong khoảng 0 đến 49 (kiểuConical không có lựa 

chọn này). 

  Apply Transparency to the Fill, Outline or Both: 

những lựa chọn áp dụng hiệu ứng trong suốt 

 All: áp dụng hiệu ứng trong suốt cho toàn bộ đường biên và màu tô. 

 Fill: áp dụng hiệu ứng trong suốt cho phần màu tô bên trong. 

 Outline: áp dụnh hiệu ứng trong suốt cho đường biên. 

 Freezer: được chọn (chìm xuống)  sau  khi  thực  hiện 

hiệu ứngTransparency sẽ giữ nguyên kết quả hiệu ứng trên đối tượng khi di 

chuyển đối tượng áp dụng hiệu ứng sang vị trí khác. 
 

di chuyển đối tượng khi không chọn Freezer di chuyển đối tượng khi chọn 

Freezer 

 Copy Transparency Properties: sao chép hiệu ứng từ một đối 

tượng đã xác lập hiệu ứng sang đối tượng chưa xác lập hiệu ứng. 

 Chọn đối tượng cần sao, click chọn công cụ Interactive 

Transparency Tool, click chọn biểu tượng Copy Transparency 

Properties trên thanh thuộc tính. 
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 Con trỏ chuột sẽ hiển thị thành biểu tượng , bạn click vào đối 

tượng cần chép. 
 

 Clear Transparency: xoá bỏ hiệu ứng Transparency và đưa đối 

tượng về trạng thái ban đầu. 

 

4.4 Hiệu ứng Distortion 

 Tạo một đối tượng cần thực hiện và chọn bằng công cụ Pick Tool. 

 Chọn công cụ Tnteractive Distortion Tool trên thanh ToolBox. 
 

 Lúc này trên trang vẽ, con trỏ chuột sẽ có hình dạng  

 Nhấp chuột lên đối tượng và kéo để tạo hiệu ứng. 
 

 Bạn có thể nhấp chuột vào các biểu tượng , và kéo để thực hiện 

thay đổi kiểu biến bạn cho đối tượng. 

 Thanh thuộc tính của công cụ Tnteractive Distortion Tool hiển 

thị như sau: 
 



76  

 Presets List: chứa các kiểu biến dạng được tạo sẵn. 

Click vào để có danh sách lựa chọn các kiểu. 
 

 Add Preset: Khi bạn tạo được một kiểu hiệu ứng, muốn lưu lại 

kiểu này bạn nhấn chọn vào nút Add Preset. Hộp thoại Save As hiển thị, 

bạn đặt   tên   cho   kiểu   hiệuứng   và nhấn   nút Save để lưu 

vào ô Presets List. Khi được lưu vào, tên kiểu hiệu ứng này 

sẽ nằm cuối trong danh sách Presets List. 

 Delete Preset: xóa một kiểu hiệu ứng trong ô Presets List. 

Bạn chỉ xoá được kiểu hiệu ứng do bạn tạo ra, không xoá được kiểu hiệu ứng 

do CorelDRAW tạo. 

 Push and Pull Disortion: thực hiện biến dạng đối tượng bằng 

cáchđẩy các mép hay kéo các mép của đối tượng ra. 
 

 Zipper: thực hiện biến dạng đối tượng bằng cách tạo hiệu ứng 

răng cưa cho những mép của đối tượng. 
 

 Twister Distortion: thực hiện biến dạng xoáy cho đối tượng. 
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Khi bạn chọn kiểu biến dạng này thì trên thanh thuộc tính sẽ hiển thị thêm các 

tính năng hỗ trợ cho kiểu biến dạng này: 
 

 

 Clockwise Rotation: thực hiện biến dạng đối tượng theo chiều 

kim đồng hồ. 
 

 Counterclockwise Rotation: thực hiện biến dạng đối tượng ngược 

chiều kim đồng hồ. 
 

 Complete Rotations: nhập số vòng xoáy 
 

số vòng xoáy được tăng lên 1 

 Additional Degrees: thay đổi góc xoáy của biến dạng xoáy. 
 

góc xoáy được giảm xuống còn 10 
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 Add New Distortion: thực hiện thêm một hiệu ứng biến dạng cho 

một đối tượng đã áp dụng hiệu ứng biến dạng. Bạn tạo một hiệu ứng biến dạng 

xong, tiếp theo click chọn vào biểu tượng Add New Distortion và thực hiện tiếp 

lại biến dạng cho đối tượng đó. 

 

 

 

 

 

 

 

 

 


Giá trị nhập trong khoảng từ 0 đến 100. 

Biên độ 40 Biên độ 84 

 Zipper Distortion Frequency: xác định tần số biến dạng 
 

tần số 6 tần số 16 

 Random Distortion: tạo biến dạng răng cưa với những đường gấp 

khúc ngẫu nhiên. 

 Smooth Distortion: tạo biến dạng răng cưa là đầu cong thay 

vì đầu nhọn. 

 Local Distortion: tạo biến dạng với giá trị biên độ tại  tâm 

hiệu ứngđạt tối đa và giảm về 0 ở hai đầu hiệu ứng. 

 Center Distortion: tùy chọn thực  hiện đưa  tâm biến  bạng 

về vị tríban đầu. Sau khi đưa tâm biến dạng đến những vị trí khác nhau, nhấp 

chọn tùy chọn này tâm biến dạng sẽ trở về vị trí mặc định banđầu. 

 Copy Distortion Properties: sao chép thuộc tính biến dạng của 

một đối tượng biến dạng này sang một đối tượng khác. 

 

 

 

 

 

 

 

 

Zipper Distortion Amplitude: xác định biên bộ biến dạng. 



79  

 Tạo một đối tượng mới, chọn đối tượng này bằng công 

cụchọn Pick Tool. 
 

 Chọn công cụ Tnteractive Distortion Tool, chọn tiếp biểu 

tượng Copy Distortion Properties trên thanh thuộc tính, con trỏ chuột sẽ 

hiển thị thành hình dạng . Click chuột vào đối tượng đã tạo hiệu 

ứngDistortion để sao chép. 
 

  Clear Distortion: xoá bọ hiệu ứng biến dạng cho một đối 

tượng đãtạo   hiệu ứng Distortion.   Chọn   vào đối   tượng   kiểu 

hiệu ứngDistortion cần bỏ và click chọn vào biểu tượng Clear Distortion, đối 

tượng sẽ trở về trạng thái ban đầu lúc chưa tạo hiệu ứng. 

 

5. Thực hành 

5.1 Thực hiện các thao tác tạo hiệu ứng. 

Mở Coreldraw và thực hiện thao tác các hiệu ứng như các hướng dẫn phía trên. 

5.2 Thiết kế hiệu ứng NEON. 

Chúng ta chuẩn bị bước tiếp theo là thiết kế bảng hiệu LED, (Nhập nội dung, bố 

cục lại toàn bộ bảng hiệu cho hop lý) 

1- Vẽ khung tổng kích thước của bảng hiệu (theo ví dụ này là 80 x 60 cm). 

2- Tạo ra khung viền của bảng hiệu dùng để chạy hiệu ứng led đuổi 

3- Nhập nội dung và bỏ màu sắc hết chỉ lấy khung outline của từng đối tượng 

4- Sắp xếp bố cục cho bảng hiệu xong (nên copy ra một bảng để đề phòng 

chuyện thay đổi nội dung của khách hàng. 

5- Convert hết tất cả những đối tượng nào là text. 

6- Dùng công cụ Artistic Media để chạy LED vào các đối tượng. 
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Vẽ khung bao và đường viền chạy LEd của bảng hiệu. Sau đó bấm tổ hợp phím 

Ctrl + K để tách 2 đối tượng này ra. 
 

Dùng công cụ Shape tool để bo tròn các góc cho đường viền LED của bảng 

hiệu. (tùy chỉnh theo ý của bạn) 
 

Sau khi Nhập nội dung ta được kết quả như hình trên (luu ý: nên copy ra một 

bảng để có trường hợp thay đổi nội dung chúng ta không mất thời gian để làm lại) 

Tiếp theo là convert hết tất cả các đối tượng là Text (Chọn những đối tượng 

Text nhấn tổ hợp phím Crtl + Q). 

Sau đó sử dụng công cụ Artistic Media tool để sắp LED vào bảng hiệu. làm 

theo từng bước như hình dưới đây. 
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Như vậy là bạn đã phần nào thấy được kết quả. 

Những bước tiếp theo là tách đường dẫn của chuỗi Led ra 

Đổi màu theo thực tế. 

 

 

 

 

 

 

 

 

 

\ 

Tách đường dẫn của chuỗi LED ra. 
 

 

Một lưu ý tôi giải thích cho cac bạn (theo hình minh họa bên dưới). 
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Một ưu điểm của phương pháp này là khi chưa tách chuỗi đèn ra khỏi đường 

dẫn chúng ta có thể thay đổi kích thước đối tượng một cách dễ dàng mà không sợ 

kích thước của lỗ cắm LED bị thay đổi kích thước. 

Làm tiếp tục cho đến khi bỏ hết đường dẫn 
 

và đây là kết quả sau khi tách hết các đường dẫn. Đổi màu theo ý khách hàng ta 

được kết quả như sau:  

 

5.3 Thiết kế vòng tròn thể thao. 

Bước 1:Trước tiên vẽ ra 2 hình như mẫu 
 

 

 

Chọn hình vàng >nhấn Ctrl + C > Ctrl + V 
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Bước 2: 

Dùng Shape (F10) > chọn như hình 
 

 

 

Kết quả: 
 

 

5.4 Thiết kế Logo 

Vẽ logo BTV 

B1. Vẽ nền HCN 

Nhấn F6 > vẽ HCN > click chọn ô màu xanh trên thanh màu. 
 

 

Chọn Text tool > Click vào màn hình > nhập text BTV. 

Chọn từng ký tự tô màu (Click giữ chuột để chọn màu chi tiết). 

Tăng size chữ B lên 180 
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B2. Tạo bóng cho text 

Chọn Pick tool > di chuyển text lệch lên trên > Click phải 

Chọn text bên dưới > tô màu xám 

 

 

 

B3. Tô viền 

Chọn Pick tool > chọn text > nhấn F12 > chọn tham số như hình > OK 
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6. Kiểm tra 

6.1 Bài 1: 
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6.2 Bài 2: 

Thiết kế Logo 
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6.3 Bài 3: 
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Mục tiêu : 

BÀI 3: VĂN BẢN VÀ CÁC HIỆU ỨNG 

Mã bài: MĐ18-03 

 Phân tích được hai loại văn bản và phạm vi áp dụng của văn bản nghệ thuật. 

 Nêu được các bước tạo văn bản dạng đoạn và văn bản nghệ thuật. Thực hiện 
chuyển đổi và hiệu chỉnh 2 loại văn bản; 

 Vận dụng thành thạo các hiệu ứng trên văn bản và áp dụng vào các bài tập thực 
tiễn; 

 Hình thành ý thức lao động là phải khẩn trương có kỷ luật, có trách nhiệm và 

sáng tạo. 

1. Tạo văn bản 

1.1 Các dạng văn bản 

Công cụ Text Tool giúp bạn thực hiện việc nhập chữ vào trang vẽ nhanh và dễ dàng. 

Trên thanh ToolBox, công cụ Text Tool đứng độc lập và không cùng nhóm với công 

cụ nào. Công cụ Text Tool có hai kiểu đối tượng hiển thị Text là Artistic Text và 

Paragraph Text. 

 Để chọn công cụ Text Tool, bạn click chuột vào biểu tượng Text Tool trên 

thanh công cụ (ToolBox). Hoặc bạn nhấn phím F8 
 

1.2 Tạo và hiệu chỉnh văn bản nghệ thuật 

Artistic Text là một đối tượng sử dụng chữ nghệ thuật trong công cụ Text Tool. Để 

tạo văn bản chữ nghệ thuật Artistic Text bạn thực hiện như sau: 

 Chọn công cụ Text Tool trên thanh ToolBox, hoặc nhấn phím F8 

 Lúc này trên trang vẽ con trỏ chuột sẽ có dạng  

 Bạn click chuột vào tại một vị trí nào đó trên trang vẽ (nếu bạn click nhấn và 

kéo chuột thì bạn tạo ra một Paragraph Text). 

 Ngay vị trí bạn click chuột sẽ có một con trỏ nhấp nháy , dấu hiệu để bạn 

nhập văn bản vào. 
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 Thanh thuộc tính của Text Tool hiển thị với các chức năng sau: 
 

Nếu bạn đã từng sử dụng bộ soạn thảo văn phòng Microsoft Word, bạn sẽ thấy các 

biểu tượng trên thanh thuộc tính này hoàn toàn tương tự như trong Word. 

  Font List: ô danh sách để bạn lựa chọn các kiểu 

chữ. 

 Font Size List: ô danh sách để bạn lựa chọn kích thước chữ. 

 Bold: lựa chọn để chữ được thể hiện in đậm. 

 Italic: lựa chọn để chữ được thể hiện in nghiêng. 

Underline: lựa chọn để chữ thể hiện nét gạch dưới. 

Horizontal Alignment: thực hiện canh hàng cho văn bản. Khi click 

chọn sẽ có một danh sách hiển thị với các biểu tượng tính năng sau: 

 

 None: canh hàng mặc định tự do. 

 Left: văn bản nhập vào, các hàng sẽ được canh đều bên trái. 

 Center: văn bản nhập vào sẽ được canh đều vào giữa. 

 Right: văn bản nhập vào sẽ được canh đều bên phải. 

 Full: văn bản được canh đều từ lề trái sang lề phải. Các dòng có 

thêm các khoảng trống để dàn đều văn bản trên các dòng giữa lề 

trái và lề phải. Dòng cuối cùng canh theo kiểu None. 

 Force Full: tương tự như kiểu Full nhưng dòng cuối cùng được 

dàn đều cho đầy một dòng. 

 Các biểu tượng  (Decrease Indent, Increase Indent, 

Show/Hide Bullet, Show/Hide Drop), chỉ thực hiện được trên kiểu 

Paragraph Text. 

  Non-printing Characters: thể hiện những ký tự điều khiển không in 

ra. 

  Format Text: khi bạn click chọn, hộp thoại Format Text hiển thị 

giúp bạn thực hiện những định dạng văn bản (bạn có thể xem thêm hộp 

thoại này trong phần Format Text). 
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  Edit Text: khi click chọn, hộp thoại Edit Text hiển thị giúp bạn nhập 

văn bản và chỉnh sửa. 

 

Thêm hoặc xóa, chỉnh sửa văn bản: 

 Click chọn đoạn văn bản cần chỉnh sửa bằng công cụ chọn Pick Tool 
 

 Click chọn vào công cụ Text Tool trên thanh ToolBox, hoặc nhấn phím F8 
 

 Dùng các phím mũi tên trên bàn phím để di chuyển đến một vị trí trong đoạn 

văn bản, nhấn phím Delete để xóa ký tự phía sau con trỏ chuột và phím 

Backspace để xóa ký tự phía trước con trỏ chuột. 

 Thực hiện chỉnh sửa xong, để thoát khỏi công cụ Text Tool bạn nhấn vào công 

cụ chọn Pick Tool. 

Hiệu chỉnh các ký tự trong Artistic Text: 

 Chọn đoạn Artistic Text cần hiệu chỉnh. 
 

 Click chọn vào công cụ Shape Tool. Con trỏ chuột trên trang vẽ sẽ có dạng 

và đồng thời đoạn Artistic Text bạn chọn sẽ được hiển thị như sau: 

 

 Biểu tượng khi bạn kéo sẽ tăng chiều dài đoạn Artistic Text. 

 Biểu tượng khi kéo sẽ tăng chiều cao đoạn Artistic Text. 

 Các nút ô vuông màu trắng khi bạn click chuột kéo thì ký tự sẽ thay đổi 

vị trí. 
 

 Khi tách rời một ký tự, bạn có thể thay đổi lại kiểu dáng, nét của ký tự này. 

 Chọn ký tự bằng công cụ chọn Pick Tool. 
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 Click chọn vào menu lệnh Arrange Convert To Curvers để thực hiện 

tách nét đối tượng. 
 

 Tiếp theo chọn công cụ Shape Tool, ký tự sẽ được hiển thị các điểm nút, 
bạn click chuột vào các điểm nút này để tạo kiểu dáng mới cho ký tự. 

 

 Khi đó thanh thuộc tính của Shape Tool hiển thị đầy đủ các chức năng 

để bạn thực hiện hiệu chỉnh (Thanh thuộc tính này bạn đã học trong bài 

công cụ Shape Tool - bạn nên xem lại). 
 

1.3 Tạo và hiệu chỉnh văn bản đoạn 

Paragraph Text là một đối tượng sử dụng chữ nghệ thuật trong công cụ Text Tool. 

Để tạo văn bản kiểu Paragraph Text bạn thực hiện như sau: 

 Chọn công cụ Text Tool trên thanh ToolBox, hoặc nhấn phím F8 

 Lúc này trên trang vẽ con trỏ chuột sẽ có dạng  

 Click nhấn và kéo chuột để tạo một vùng soạn thảo Paragraph Text 
 

 Trong khung nhập liệu sẽ có con trỏ chuột đang nhấp nháy, dấu hiệu để bạn 

nhập văn bản vào. Để kết thúc một đoạn, bạn nhấn phím Enter để xuống dòng. 
 

 Thanh thuộc tính của Text Tool hiển thị với các chức năng sau: 
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Các chỉnh sửa tương tự như văn bản nghệ thuật. 

2. Hiệu ứng trên văn bản 

2.1 Tạo văn bản theo đường dẫn 

Fit Text To Path uốn văn bản chạy theo một đường dẫn bất kỳ, thực hiện cho cả 

Artistic Text và Paragraph Text. 

1. Thực hiện: 

 Tạo một đoạn văn bản. 
 

 Tạo một đối tượng có đường dẫn (ví dụ: đường tròn, một đường cong, . . .) 
 

 Click chọn lại đoạn văn bản, chọn tiếp menu lệnh Text / Fit Text To Path. 
 

 Lúc này trên trang vẽ, con trỏ chuột sẽ hiển thị hình dạng 

 Click con trỏ chuột vào đường dẫn (ví dụ là hình tròn), đoạn văn bản sẽ được 

uốn cong theo đường dẫn. 
 

2.2 Tạo văn bản theo khung 

- Tạo khung cho văn bản. Khung phải kín. 
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- Nhấp chuột chọn công cụ Text. Đưa con trỏ lại gần khung, đến khi con trỏ xuất 

hiện biểu tượng  

- Nhấp chuột trái 

- Xác lập lại các thuộc tính Font, Font Size, Font Style trên thanh đặc tính. 

- Nhập văn bản. Nhập xong chọn lại công cụ Pick, đổ văn bản vào hình bao. 

-  

3. Áp dụng các hiệu ứng lên văn bản. 

Thực hiện kéo giãn hoặc thu hẹp các chuỗi ký tự cho vừa khớp với khung soạn thảo 

mà vẫn giữ nguyên kích thước khung soạn thảo. Lệnh này chỉ thực hiện được với kiểu 

văn bản Paragraph Text. 

 Chọn khung soạn thảo 
 

 Chọn menu lệnh Text / Fit Text To Frame. 
 

 Văn bản sẽ được hiệu chỉnh so với khung soạn thảo như sau: 
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2. Align To Baseline: 

Thực hiện đưa ký tự đã ra khỏi đường chuẩn trở về như cũ. Chỉ thực hiện được với 

Artistic Text. 

Sau khi đã di chuyển các ký tự ra khỏi đường chuẩn của Artistic Text, muốn đưa trở 

về như cũ bạn thực hiện: 

 Chọn đối tượng Artistic Text. 
 

 Click chọn vào menu lệnh Text / Align To Baseline 
 

 

 Đoạn văn bản Artistic Text sẽ được đưa trở về với trạng thái ban đầu. 
 

 

3. Straighten Text: 

Thực hiện đưa chuỗi ký tự trong đoạn văn bản đã thực hiện di chuyển, chỉnh góc, hoặc 

đã tạo hiệu ứng với Fit To Text Path trở về trạng thái ban đầu. 

 Chọn chuỗi ký tự cần thực hiện. 
 

 Chọn menu lệnh Text / Straighten Text 
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 Văn bản sẽ được trả về trạng thái ban đầu. 
 

 

4. Change Case: 

Thực hiện chuyển ký tự từ hoa sang thường và ngược lại. 

 Chọn chuỗi ký tự cần chuyển đổi. 
 

 Chọn menu lệnh Text / Change Case . . . 
 

 

 Hộp thoại Change Case hiển thị với các lựa chọn sau: 
 

 Sentence case: chỉ có ký tự đầu dòng là viết hoa, các ký tự còn lại là 

thường. 
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 lowercase: tất cả các ký tự sẽ trở thành ký tự thường. 
 

 UPPERCASE: tất cả các ký tự sẽ trở thành ký tự hoa. 
 

 Title Case: chỉ có ký tự đầu của chữ là hoa. 
 

 tOGGLE cASE: ký tự đầu của chữ sẽ trở thành thường, các ký tự sau 

thành ký tự hoa 
 

 

5. Convert: 

Thực hiện chuyển đổi qua lại giữa Artistic Text và Paragraph Text. 

 Nếu bạn chọn đối tượng là Artistic Text thì trên menu lệnh sẽ hiển thị lệnh sau: 
 

 Ngược lại nếu bạn chọn đối tượng là Paragraph Text thì trên menu lệnh sẽ 

hiển thị lệnh sau: 
 

 

4. Thực hành 

4.1 Tạo văn bản dạng đoạn và văn bản nghệ thuật 

Bộ gõ tiếng Việt và quan trọng nhất là phải có font VNI- 

Thuphap . 

Đầu tiên mở (Open) một trang giấy trắng - chọn 

công cụ Text Tool (hay nhấn F8) - chọn font VNI- 

Thuphap. Gõ một chữ vào trang giấy, ví dụ chữ “Phúc”. 

Nhấn phím Space Bar (hay Pick Tool) để chọn 

toàn bộ chữ “Phúc” - Nhấn Shift + F2 để phóng to chữ 

“Phúc”. Bây giờ thì tuỳ ý thích mỗi người mà “bo” chữ 

này theo dạng tròn hay hình vuông! Ở công cụ Pick Tool, 
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nhấn tổ hợp Ctrl + Q để biến chữ thành hình. Vào menu Arrange/ Break Curve Apart 

(hay nhấn Ctrl + K) để “rã” hình chữ “Phúc” ra thành các chữ cái riêng biệt. 

Mở trang giấy mới, vào menu Windows/ Tile Vertically để chia đôi màn hình, 

một bên là trang giấy chữ “Phúc”, một bên là trang giấy trắng. 

Dùng công cụ Rectangle Tool (hay F6) để vẽ một hình 

vuông (giữ phím Ctrl khi kéo chuột) kích thước tuỳ ý (nhưng 

phải bằng nhau cho tất cả các chữ khác) bên trang giấy trắng. 

Nhấn Shift + F2 phóng to hết hình vuông - dùng công cụ Pick 

Tool kéo từng chữ cái ở trang giấy đầu tiên vào ô vuông này, sau 

đó xoá trang giấy đó đi rồi phóng to trang còn lại (có hình vuông 

và chữ). Các bạn cứ kéo và chỉnh sao cho các chữ cái nằm gọn trong hình vuông đó và 

thấy vừa mắt là được. Đánh dấu chọn hình vuông - nhấn Delete xoá hình vuông - nhấn 

Ctrl + A để chọn hết các chữ - nhấn trái chuột vào ô màu vàng trên thanh màu để tô 

màu chữ - nhấn phải chuột vào ô màu đỏ trên thanh màu để tô viền. Nhấn Ctrl + A - 

nhấn Ctrl + G (hay menu Arange/ Group) để nhóm toàn bộ chữ “Phúc” này lại - chọn 

File/ Save As để lưu với tên file tuỳ chọn. 

Tuy nhiên, các bạn cũng thấy “bo” chữ theo hình vuông 

không đẹp lắm. Muốn đẹp mắt hơn, chúng ta có thể “bo” theo 

hình tròn. Chọn công cụ Ellipse Tool (hay F7) để vẽ hình tròn 

bên trang giấy trắng (giử phím Ctrl khi kéo chuột). 

Sau khi kéo hết các chữ vào hình tròn, dùng công cụ Shape 

Tool (hay F10) để “nắn” cong chữ. Nhấp phải chuột lên chữ rồi 

chọn To Curve để biến nét thẳng thành nét cong - cẩn thận kéo cạnh chữ “bo” theo 

hình tròn. Nếu thấy có nhiều nút trên cạnh chữ, khó nắn quá các bạn cứ bỏ bớt các nút 

này đi (nhấp phải chuột - Delete). Tô màu và viền chữ giống như trên. Làm xong nhớ 

Group và lưu lại. 

Sau khi làm xong tất cả các chữ, các bạn có thể in 

ra giấy (nếu có máy in màu và giấy màu thì... tuyệt vời). 

Cắt rời từng chữ và dán lên băng giấy hay băng vải đỏ 

(có thể để ngang cho câu chúc hay dọc cho hai câu 

đối).Ngoài ra cũng có thể tạo dáng chữ theo hình vuông 

xéo cũng được. Cách làm cũng tương tự như làm với 

hình vuông ngang ở trên. 

4.2 Thiết kế một biển hiệu quảng cáo cho cửa hàng 

Gồm có thành phần chính cơ bản (không nhất thiết phải dúng theo như vậy): 

1. Tên cửa hàng, công ty, shop… 

2. Giới thiệu ngành nghề chính 

3. Địa chỉ & số điện thoại 

4. Hình ảnh trang trí. 

Vậy tùy theo yêu cầu của khách hàng mà bạn chuần bị những thứ này để chúng ta bắt 

tay vào thiết kế nhé. 
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Sau đay là một ví dụ cụ thể: 
 

Bước 1 xác định kích thước và phân chia các thành phần của bảng hiệu: 

Vẽ một khung hình chữ nhật trong corel theo đúng kích thước thực tế của bảng hiệu. 

vd 400 x 120 (cm) 
 

Phân chia phần chân của bảng hiệu. 
 

Tô màu 
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Đưa nội dung vào: 
 

 

Tạo hiệu ứng cho Chữ DUY: 

Lệnh contour 
 

Chỉnh thông số theo hình hoặc theo ý của bạn (lệnh này nhằm tạo ra một đối tượng 

đồng dạng có kích thước lớn hoặc nhỏ hơn đối tượng gốc ban đầu) 
 

 

Kết quả đạt được 
 

 

Chọn viền đỏ mới được tạo của chữ DUY (nếu chưa chọn) tiếp tục dùng lệnh 

Arrange => Break Contour group apart 

Chọn lại viền đỏ dùng tiếp lệnh contour thêm một lần nữa 
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Kết quả như sau: 
 

Tạo viền cho các dòng chữ khác. 

Chọn dòng chữ “SỬA CHỮA – MUA BÁN – TRAO ĐỔI” màu vàng sau đó click 

chuột phải vào ô màu cam -> tạo đường viền màu cam cho dòng chữ màu vàng. 
 

Định lại độ dày cho đường viền: 

Nhấn F12 hoặc làm theo hướng dẫn như hình bên 
 

 

Hãy tự kiểm tra kết quả và làm tương tự với dòng chữ màu xanh nhưng hãy chọn màu 

đường viền là màu trắng cho nổi bật. 

Kết quả: 
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Hãy chuẩn bị một số hình ảnh cho phù hợp với nội dung bảng hiệu. 
 

Chọn cả hai tấm hình bằng công cụ pick tool sau đó dùng lệnh 

Effect -> PowerClip -> Place inside Container… 

 

Con trỏ chuột sẽ biến thành một hình mũi tên lớn và bạn hãy click vào cái nền bảng 

hiệu (nhớ click chính xác vào nền bảng hiệu đừng click và đối tượng khác nhé. Và 

chúng ta được kết quả. 
 

Kết quả : 
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4.3 Tạo chữ 3 chiều và bóng đổ. 

Gõ dòng text lên trang trắng và convert nó thành dạng đường cong, nhấn Ctrl+Q: 
 

Bước 2: Chọn Extrude trong hộp công cụ: 
 

Bước 3 

Tạo hiệu ứng 3D với công cụ Extrude bằng cách kéo chuột. 
 

Bước 4 

Trên thanh thuộc tính lựa chọn quay của công cụ. 
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Bước 5 

Trên thanh thuộc tính chọn Extrude rotation. 
 

 

Bước 6 

Lấy công cụ vừa chọn, đặt chuột lên khoảng trắng của dòng chữ nhấp chuột phải chọn 

Break Extrude Group Apart. Sau đó chọn tất cả các đối tượng và nhấn Ctrl+G để 

nhóm chúng lại với nhau. 
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Bước 7: Quay trở lại hộp công cụ và lựa chọn Interactive Envelope. 
 

Bước 8: Chọn chữ, đặt chuột lên dòng text và kéo, trong khi kéo ta giữ phím Shift và 

di chuyển nó lên hoặc xuống. 

 

 

Bước 9: Quay trở lại hộp công cụ. Với công cụ Fill ta chọn Fountain Fill hay nhấn 

F11. 
 

Bước 10: Hộp thoại Color belend hiện ra ta chọn Custom. Make color by clicking on 

the point in beginning of the color window. More clickin more color you get. 
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Bước 11: Có 3 màu để lựa chọn, màu đầu tiên là Cian hay R 0, G 147, B 221, thứ hai 

là màu trắng, thứ ba là màu xanh da trời hay R 0, G 124, B 195 và kết thúc là màu 

trắng. Tạo các kiểu màu giống nhau. 
 

Bước 12: Lặp lại với những màu giống nhau ở trên. Với màu đen, Cian, đen, đen, 

trắng. Từ phải sang trái. 
 

Bước 13: Tạo nền với Rectangle tool. Đặt nền phía sau hiệu ứng 3D, (hay nhấn Ctrl + 

Page Down) 
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Bước 14: Mở Fountain fill. Chọn Custom. Chọn góc quay hình nón là 90 độ. 

Ta đổ màu lần lượt là 50% đen - trắng - 10% đen - trắng. 

 

Bước 15: Chọn chữ 3D và mở hộp công cụ. Chọn Drop shadow. 
 

Bước 16: Tạo kiểu bóng với con trỏ. 
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Bước 17: Đặt chuột lên bóng và kích chuột phải lên đó. Chọn break drop shadow 

group apart. 
 

Bước 18: Kích đúp chuột lên bóng để tạo độ quay. Sau đó quay bóng và đặt phía dưới 

dòng text. 
 

Bước 19: Hoàn thành 
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5. Kiểm tra 

5.1 Bài 1 
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5.2 Bài 2 
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5.3 Bài 3 
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Mục tiêu : 

BÀI 4: XỬ LÝ CÁC ĐỐI TƯỢNG NHÚNG 

Mã bài: MĐ18-04 

Trình bày các thao tác chèn và xử lý ảnh Bitmap trên môi trường Corel Draw; 

Vận dụng thành thạo vào thiết kế các ảnh vector; 

Hình thành ý thức lao động là phải khẩn trương có kỷ luật, có trách nhiệm và sáng 

tạo. 

1. Xử lý ảnh trong Corel draw 

1.1 Chèn tranh 

Bạn đã biết cách khởi động Corel DRAW, khá quen mắt với cửa sổ Corel 

DRAW, khá quen tay với chuột (chuột máy tính í!), xem như "đã tỏ đường đi lối về". 

Giờ là lúc bạn có thể bắt đầu tập tành các thao tác thông thường trên đối tượng của bản 

vẽ, các thao tác sẽ lặp đi lặp lại trong suốt thời gian bạn làm việc với Corel DRAW sau 

này. 

Đối tượng! Bạn đã nghe nhắc đến đối tượng vài lần nhưng chưa một lần gặp 

mặt. Đối tượng là bất cứ thứ gì được đưa vào bản vẽ, được tạo bởi chính Corel DRAW 

hoặc bởi các phương tiện khác. Dù các đối tượng có thể có nguồn gốc khác nhau, có 

bản chất khác nhau nhưng một khi đã nằm trên bản vẽ của Corel DRAW, bạn thao tác 

với chúng theo cùng cách thức. Để thuận tiện trong bước đầu, ta hãy lấy một đối tượng 

có sẵn ở đâu đó, từ trên mạng chẳng hạn. 

Lấy đối tượng từ mạng 
 

Chọn Tools > Scrapbook > Contents 

on the Web 

Cửa sổ neo đậu Scrapbook hiện ra, 
đồng thời Windows yêu cầu bạn nối kết 
với Internet (nếu bạn chưa "ở trên 
mạng") 

Bấm-kép vào thư mục Clipart rồi bấm 
kép vào thư mục Fun_people trong cửa 
sổ Scrapbook 

Bạn thấy một số hình vẽ vui vui 

(hình 1) 
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Scrapbook là nơi cất trữ những hình vẽ linh tinh để "làm vốn". Với thao tác vừa thực 

hiện, bạn đã truy xuất bộ sưu ảnh (clip-art) do hãng Corel cung cấp. Đó là những hình 

vẽ xinh xinh được tạo bởi Corel DRAW và được sắp xếp theo chủ đề. 
 

Trỏ vào hình vẽ nào đó mà bạn thích 

trong cửa sổ Scrapbook, kéo nó vào 
miền vẽ 

Hình đã chọn xuất hiện trên miền vẽ. 

Bạn đã có được đối tượng đầu tiên 

Xin nhắc bạn, khi nghe nói "kéo", bạn phải ấn giữ phím trái của chuột. Bạn chỉ thả 

phím ấy lúc hoàn thành thao tác. 

Thu gọn cửa sổ neo đậu Scrapbook  

 

1.2 Hiệu chỉnh đối tượng tranh 

Một cách tự nhiên, mỗi khi muốn làm chi đó với một đối tượng, ta phải chọn 

đối tượng ấy. Nhờ vậy, Corel DRAW mới biết rằng bạn muốn tác động vào đối tượng 

nào. Để chọn đối tượng, bạn dùng công cụ chọn (pick tool) . Đó là công cụ đầu tiên 

của hộp công cụ (ở cạnh trái miền vẽ). 

Bấm vào công cụ chọn Lấy công cụ chọn (hình 3) 

Bấm vào hình vẽ Tám dấu chọn (ô vuông nhỏ, màu đen) 

xuất hiện quanh hình vẽ 

Bấm vào đâu đó trên miền vẽ Các dấu chọn biến mất. Hình vẽ được 

"thôi chọn" 

Bấm vào hình vẽ Tám dấu chọn lại xuất hiện quanh hình 

vẽ 
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Sau khi bấm vào giữa hình vẽ để chọn, bạn thấy xuất hiện các dấu chọn (selection 

handle), tức là các ô vuông nhỏ, màu đen bao quanh hình, biểu thị tình trạng "được 

chọn". Về sau, bạn sẽ thấy rõ rằng đối tượng vừa tạo ra đương nhiên ở trong tình trạng 

"được chọn". Tám dấu chọn giúp bạn hình dung về một khung chữ nhật bao quanh đối 

tượng. Người ta gọi đấy là khung bao (bounding box) của đối tượng. Khi nào bạn nghe 

nói về kích thước của đối tượng, thực chất đó là kích thước của khung bao đối tượng. 

Bạn để ý, giữa hình vẽ có một dấu X. Đó là "tay nắm" để bạn di chuyển (move) đối 

tượng. Cụ thể, muốn di chuyển đối tượng, bạn trỏ vào dấu X ở giữa đối tượng được 

chọn (sao cho dấu trỏ của chuột biến thành "mũi tên bốn đầu") rồi kéo đối tượng đến 

vị trí mới. 
 

Trỏ vào dấu X ở giữa hình vẽ Dấu trỏ chuột biến thành "mũi tên bốn 

đầu" 

Kéo hình vẽ sang trái hoặc sang phải 
 

Như bạn thấy, thao tác di chuyển đối tượng rất tự nhiên, tựa như ta di chuyển một vật 

trên bàn: chạm tay vào vật, giữ chặt và đưa vật đến vị trí mới. Các thao tác co dãn 

(stretch), quay tròn (rotate) và kéo xiên (skew) đối tượng cũng được thực hiện một 

cách tự nhiên giống như vậy. 

2. Các hiệu ứng trên ảnh 

2.1 Biên tập ảnh 

Trên "hộp công cụ" Toolbox ở cạnh trái miền vẽ có một cái "kính lúp" giúp 

bạn "nhìn gần lại" (zoom in) hoặc "nhìn lui xa" (zoom out) các đối tượng trong miền 

vẽ. Nói một cách... trịnh trọng, đó là công cụ nhìn (zoom tool). Cách dùng rất đơn 

giản. Bạn chỉ việc nắm lấy "kính lúp" rồi bấm vào chỗ mà bạn muốn "nhìn gần lại" 

hoặc "căng" một khung xác định phạm vi cần quan sát. 

Bấm vào "kính lúp" trên hộp công cụ  

Trỏ vào phía trên, bên trái hình vẽ và kéo 

"kính lúp" xuống dưới, qua phải 
Bạn thấy hình vẽ lớn lên (hình 2) 
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Lần lượt chọn từng khả năng vừa nêu trên 
thanh công cụ Property Bar và quan sát 

kết quả 

 

Xin nhấn mạnh rằng thao tác vừa thực hiện chỉ điều chỉnh tầm nhìn chứ không 

ảnh hưởng đến đối tượng. So với kích thước trang in, kích thước hình vẽ của bạn vẫn 

thế, không thay đổi.. Ngay khi cầm lấy "kính lúp", bạn để ý thanh công cụ Property 

Bar lập tức thay đổi, bày ra các khả năng lựa chọn như hình 3, giúp bạn điều chỉnh 

tầm nhìn theo những cách khác nhau (để biết tên gọi của từng khả năng lựa chọn, bạn 

biết đó, ta chỉ cần trỏ vào biểu tượng tương ứng và chờ chừng một giây). 
 

Nếu bấm vào Zoom In , bạn sẽ "nhìn gần lại" trang in với độ phóng đại là 2 (tức là 

thấy hình ảnh lớn lên gấp đôi). Ngược lại, khi bấm vào Zoom Out , bạn có thể "lui 

ra xa", thấy hình ảnh nhỏ đi phân nửa. Zoom to Selected giúp bạn chỉnh tầm nhìn 

vừa đủ bao quát mọi đối tượng đã chọn (ta sẽ xem xét cách chọn đối tượng trong phần 

tiếp theo). 

Nếu chọn Zoom to Page , tầm nhìn sẽ được chỉnh sao cho vừa đủ bao quát toàn 

trang in. Tương tự, Zoom to Page Width và Zoom to Page Height giúp bạn lấy 

tầm nhìn vừa đủ bao quát chiều rộng hoặc chiều cao của trang. 
 

Các thao tác điều chỉnh tầm nhìn được thực hiện rất thường xuyên khi làm việc với 

Corel DRAW. Do vậy bạn nên lặp lại nhiều lần thao tác như vậy cho đến khi cảm thấy 
hoàn toàn thoải mái khi cầm "kính lúp". Trong những công việc mà ta sẽ làm từ đây về 

sau, bạn cứ tự nhiên dùng "kính lúp" để "nhìn gần lại" hoặc "lui ra xa" bất cứ lúc nào 
có nhu cầu. 

 

 

2.2 Quốn góc ảnh 

Đầu tiên bạn chọn đối tượng convetbimap - Để chuyển thành ảnh bitmap chế độ 

transparent Background... 
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Thực hiện theo các bước sau: 
 

 

Lúc này bạn chọn nhiều cách, thử chọn một cách xem..... 
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Kết quả thu được như sau: 
 

 

2.3 Co giãn ảnh 

Bạn có thể làm cho đối tượng mập ra hay ốm đi, cao lên hay lùn xuống tùy thích bằng 

cách trỏ vào một trong các dấu chọn (sao cho dấu trỏ chuột biến thành mũi tên hai đầu) 

và kéo chuột tới lui cho đến khi đối tượng đạt được dáng điệu như ý. 

 

Trỏ vào dấu chọn bên dưới, ở giữa 
Dấu trỏ chuột biến thành mũi tên hai đầu, 

thẳng đứng 

Kéo chuột lên trên Nhân vật của ta bị "bẹp gí" (hình 1) 

Thả phím chuột Các dấu chọn tái hiện 

Chọn Edit > Undo Stretch hoặc ấn 

Ctrl+Z 

 

Nhân vật "đẹp giai" trở lại 

 

Hình 1 
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Hình 2 

Phóng to, thu nhỏ đối tượng 

Trong thao tác vừa thực hiện, ta đều làm biến dạng nhân vật do chỉ thay đổi chiều cao 

hoặc chiều rộng của hình. Nếu muốn hình được phóng to hoặc thu nhỏ trên trang in 

nhưng không bị mất cân đối, bạn kéo dấu chọn ở một trong bốn góc. Khi ấy, chiều 

rộng và chiều cao thay đổi cùng lúc, tỉ lệ giữa chúng được giữ nguyên. 

 

Trỏ vào dấu chọn ở góc dưới, bên phải 
Dấu trỏ biến thành mũi tên hai đầu nằm 

nghiêng 

 

Kéo chuột qua phải, xuống dưới 
Nhân vật lớn dần theo sự điều khiển của 

bạn 

Kéo chuột qua trái, lên trên Nhân vật nhỏ dần đi 

Thả phím chuột Nhân vật có kích thước mới 

Ấn Ctrl+Z Nhân vật trở lại kích thước cũ 

Để nhấn mạnh sự khác biệt với thao tác co dãn, gây biến dạng đối tượng, người ta gọi 

chung thao tác phóng to, thu nhỏ không làm đối tượng biến dạng như bạn vừa thực 

hiện là định cỡ (scale) đối tượng. 

Bạn nên lặp lại nhiều lần thao tác nêu trên cho quen tay, lấn lượt nắm lấy các dấu chọn 

ở các góc khác nhau, tùy thích phóng to hình nhân vật để quan sát thật rõ các đường 

nét. 

3. Hiệu ứng trong suốt trên ảnh 

Chúng ta sẽ sử dụng hình ảnh bảng hiệu đã làm ở bài tập trước để làm hiệu ứng trong 

suốt trên ảnh 

Tạo hiệu ứng trong suốt cho hình ảnh 
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Sử dụng lệnh Powerclip để cắt xén hình vào trong nền bảng hiệu 
 

 

4. Thực hành 

4.1 Chèn ảnh vào trang vẽ 

Vào File/Import 
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Hộp thoại Import hiện ra, chọn đường dẫn đến file ảnh cần chèn vào trang vẽ, sau đó 

click vào nút Import 
 

 

Hình ảnh đã được chèn vào trang vẽ. 
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4.2 Hiệu chỉnh chất lượng ảnh 

Bước 1: Vẽ dáng vịt đang bơi 

- Chọn công cụ Bezier vẽ dáng con vịt đang bơi (hình 1). 

- Vẽ tiếp các phần đuôi, cánh, mắt và mỏ của con vịt. Riêng phần mắt thì sử dụng công 

cụ vẽ hình Ellipse (hình 2). 
 

 

Hình 1 
 

Hình 2 

 

 

Bước 2: Tô màu 

- Tô màu tùy thích, riêng phần mỏ nên tô màu kem và vẽ thêm đốm màu trên mỏ. Sau 

khi tô màu xong bỏ hết các đường line đen (hình 3, 4). 
 

 

Hình 3 
 

Hình 4 

 

 

Bước 3: Vẽ hồ nước 

- Chọn công cụ vẽ hình chữ nhật (Rectangle Tool) vẽ một hình chữ nhật. 

- Chọn công cụ Fill Tool - Fountain Fill, tô chuyển sắc từ xanh nhạt sang xanh đậm. 
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- Gắn con vịt vào hồ nước (hình 5). 
 

 

Hình 5 

Bước 4: Tạo chuyển động của vịt dưới mặt nước 

- Vẽ các vệt sóng xung quanh vịt (hình 6). 
 

 

Hình 6 

 

 

Bước 5: Tạo thêm đàn vịt con 

- Chọn con vịt và vệt sóng mới tạo Group lại (chọn Object - Group). 

- Click chuột trái kéo ra ngoài và click chuột phải ta tạo được con thứ hai. 

- Chọn con vịt mới tạo, kéo một trong 4 node ở 4 góc để được con vịt nhỏ hơn (hình 

7). 
 

 

Hình 7 

 

 

- Tương tự hai bước trên, ta sẽ tạo được một đàn vịt. 
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- Ta được kết quả như hình 8. 
 

 

Hình 8 

 

 

4.3 Tạo khung ảnh. 

Chọn vào ảnh cần tạo khung 
 

Click chuột phải vào đối tượng chọn Properties 
 

Hộp tùy chỉnh Object Properties xuất hiện, chọn các khung cần tạo. 
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Có thể vào Advanced để chọn thêm các khung viền khác. 
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5. Kiểm tra 

Sử dụng các công cụ vẽ đôi giày và làm hiệu ứng cuốn góc ảnh. 
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Mục tiêu : 

BÀI 5: GIỚI THIỆU MỘT SỐ BỘ ỨNG DỤNG CỦA COREL 

Mã bài: MĐ18-05 

Trình bày được các ứng dụng của bộ Corel; 

Vận dụng hỗ trợ trong quá trình thiết kế trên Corel Draw; 

Hình thành ý thức lao động là phải khẩn trương có kỷ luật, có trách nhiệm và sáng 

tạo. 

1. Corel PhotoPaint 

1.1 Các tính năng của Corel PhotoPaint 

Corel® PHOTO-PAINT® là một phần mềm chỉnh sửa ảnh chuyên nghiệp cho phép 

bạn nhanh chóng và dễ dàng tút lại và cải thiện ảnh. Được tích hợp với CorelDRAW, 

nó đặc biệt hữu dụng trong sản xuất đa tác vụ bao gồm chỉnh sửa hình ảnh. 
 

Hoàn toàn hỗ trợ 24 bit màu. Tương thích với các định dạng RAW cho hàng trăm 

loại máy ảnh. Tính năng duỗi ảnh giúp bạn nhanh chóng và dễ dàng tinh chỉnh các 

bức ảnh được quét hoặc chụp ở góc. Thêm nhiều tính năng và hiệu ứng giờ cung cấp 

phản hồi hoành đồ theo thời gian thực, vì vậy bạn có thể xem trước sự thay đổi và so 

sánh kết quả khi bạn tinh chỉnh tông ảnh, áp dụng hiệu ứng hay xử lí file RAW. Tính 

năng Cut out lab mạnh mẽ, dễ dùng có thể tìm thấy trong CorelDRAW và Corel 

PHOTO-PAINT, là một sự bổ sung lí tưởng cho công việc của bạn. 

1.2 Giao diện làm và nhập ảnh xử lý 

Giao diện chương trình Corel Photo-Paint 
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Để thêm một hình ảnh vào xử lý ta thực hiện các thao tác sau: 
 

Hộp thoại xuất hiện, chọn đường dẫn đến file ảnh muốn chỉnh sửa. 
 

Ảnh đã xuất hiện, giờ bắt đầu thực hiện các thao tác hiệu chỉnh. 
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Thanh công cụ của Corel Photo-Paint 
 

Các công cụ trong Corel Photo-Paint cũng tương tự như CorelDraw. 

1.3 Các thao tác hiệu chỉnh ảnh 

Trên thanh Menu ngang của Corel Photo-Paint ngoài các công cụ đã xuất hiện trong 

Corel Draw còn có thêm nhóm công cụ Image 
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2. Corel Capture 

2.1 Các tính năng của Corel Capture 

Khi  nói  đến chụp  màn  hình chẳng  ai  nghĩ  đến  COREL  mà  chỉ 

lên www.google.com hay www.yahoo.com search từ khóa chụp màn hình và cho kết 

quả là rất nhiều phần mềm như SNAPIT, EASY CAPTURE, FastStone Capture... 

Những phần mềm này cũng rất hay trong việc chụp màn hình và dùng cho in ấn. 

Nhân dịp, COREL công bố phiên bản CorelDRAW® Graphics Suite X5 (gọi tắt 

là COREL X5) đã được rất nhiều dân thiết kế đồ họa cài đặt và mang vào sử dụng cho 

mục đích thiết kế, chế bản và in ấn. Tôi cũng xài Corel X5 và cảm nhận COREL X5 

rất mạnh trong thiết kế đồ họa và đã sửa chữa rất nhiều những khuyết điểm liên quan 

đến in ấn còn tồn đọng trong COREL X4. 

Khi nghiên cứu về CorelDRAW® Graphics Suite X5, tôi thấy có một tính năng rất 

hay của COREL X5 trong phiên bản này là chức năng chụp màn hình với COREL 

CAPTURE X5 ®. COREL X5 với chức năng chụp màn hình được dùng với nhiều 

mục đích: 

+ Làm bài giảng, bạn cần chụp lại các thao tác khi xử lý để show cho học viên xem 

từng thao tác xử lý file. Tôi đã từng đi dạy đồ họa ngày xưa chưa có phần mềm chụp 

màn hình thì tôi hay dùng chứ năng PRINT SCREEN của windows (Bạn có thể nhìn 

thấy trên bàn phím máy tính nút này) để copy vào CLIPBOARD và sau đó vào 

PHOTOSHOP hay PHOTOPAINT paste vào. Rất mất thời gian và bạn phải cắt vùng 

hình ảnh dư thừa 

+ Dùng để in ấn: KHi thấy trên mạng có một hình một cô gái rất xinh nhưng tìm 

source download rất khó khăn dẫn đến bạn không thể download về, còn nếu bạn 

SAVE AS IMAGE từ INTERNET EXPLODER thì hình ảnh chất lượng trên website 

rất kém chỉ để view chứ không để in được. 

Với COREL X5 và phần mềm con của nó là Corel CAPTURE X5 ® thì mọi chuyện 

trên sẽ được giải quyết trong tầm tay. 

Bước 1: Khởi động Corel Capture X5 từ corel 

KHởi động Corel X5 

Bạn chọn vào công cụ trên thanh công cụ phía trên (hàng ngang phía trên,biểu tượng 

đứng thứ 12 từ trái sang phải bắt đầu từ biểu tượng NEW, có cái màn hình và dấu X 

màu đỏ. Bạn thử tìm xem nhé). Chọn chức năng COREL CAPTURE. 
 

 

 

Bước 2: Phải tạo một Capture PRESENTS (hồ sơ tiến trình công việc cho riêng bạn) 

trong Corel X5 bằng cách bấm vào nút + . Bạn có thể đặt tên là Capture Corel 

http://www.google.com/
http://www.yahoo.com/
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X5 hay chụp màn hình với COREL ... cho riêng bạn. Bấm SAVE sau khi đặt tên 

xong. 
 

 

 

2.2 Các thao tác trên Corel Capture 

Thông số SOURCE: 

+ Windows Capture: Cho phép thiết lập màn hình chụp 
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+ Area Capture: Chọn kiểu vùng chụp màn hình. Bạn có thể chọn RECTANGULAR 

AREA: hình chữ nhật, ELLIPTICAL AREA: hình elip bà FREEHAND AREA LÀ 

BẠN có thể vẽ tay vùng hình ảnh cần chụp trên màn hình. 
 

 

 

- Menu Capture: Cho phép chụp có menu đi kèm và cho phép thay màu màn hình 

Background (màu nền) khi chụp. 
 

 

 

THÔNG SỐ ACTIVATION: 

Cho phép thiết lập phím nóng (hotkey) ở đây tôi chọn F7 và mỗi khi tôi bấm F7 thì 

phần mềm sẽ tiến hành kích hoạt chụp hình ảnh 
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+ Initial delay before fist capture (1-60 sec) cho phép bạn thiết lập thời gian trì hoãn 

việc chụp. Cái này giống như bạn chụp máy chụp kỹ thuật số bằng chân máy. Bạn 

canh hết hình người nhà xong thì thấy mình còn đứng nhe răng ngay máy chụp mà 

chưa đứng vào hàng, bạn cho máy trì hoạn việc chụp sau 10 giây để bạn chạy và hàng. 

Cười thật to và bạn sẽ có mặt trong tấm hình cùng gia đình. 

+ Hide icon when capturing: Cho phép ẩn ICON chụp của COREL Capture đi trong 

quá trình chụp 

+ Show area in zoom (area capture only): chỉ zoom khi sử dụng chức năng chụp theo 

vùng 
 

 

 

+ Capture Cursor (cái này cho phép thiết lập biểu tượng khi chụp) giống như biểu 

tượng lúc một phần mềm nào đó khi chạy (loading) là đồng hồ cát. 
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THÔNG SỐ IMAGE: 

Cực kỳ quan trọng trong in ấn: 
 

 

+ Nếu chỉ xem trên màn hình hoặc web bạn chọn RESOLUTION 72 dpi và 

SCALE: 100% để chụp theo tỷ lệ 1:1 

+ Nếu in ấn OFFSET : do độ phân giải màn hình thường là 600x800 px hay 

1024x768 px dẫn đến kích thước file rất nhỏ. Do đó bạn phải dùng thủ thuật sau: 

Resolution: Bạn có thể chọn là 300 đến 350 DPI 
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Scale (cực kỳ quan trọng): bạn chọn từ 600 % đến 1000 % cho COREL 

CAPTURE phóng hình và vào PHOTOSHOP kiểm tra lại kích thước hình (photoshop 

: Image --> Image size). Khi bạn dùng thủ thuật này Corel X5 sẽ tính toán với thuật 

toán cực kỳ hay làm sao cho ảnh đẹp nhất khi chụp dù có phóng lớn đến 1000 %. Tôi 

đã thử phóng 600% và với resolution là 300 dp. Vào photoshop tôi được tấm hình kích 

thước rất lớn và cực kỳ đẹp. 

Bạn thử xem sao nhé với từng độ SCALE khác nhau và chọn cho mình một thông số 

thích hợp nhất để cho ra kích thước ảnh phù hợp với mục địch sử dụng: In a4, in A3 

hay in quảng cáo khổ lớn bằng máy kỹ thuật số. 

THÔNG SỐ DESTINATION: 

Thiết lập nơi lưu file chụp. Bấm vào nút phía bên trái trên file. Tôi chọn nơi lưu file là 

DESTOP và tên hình ảnh là COREL và chọn định dạng là JPG 
 

 

 

THÔNG SỐ OPTIONS: 
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+ Notify end of capture: Thông báo sau khi chụp xong màn hình 

+ Enable sond: Cho phép có tiếng phát ra giống như chụp ảnh (lưu ý phải có loa mới 

nghe được) 
 

 

 

Sau khi thiết lập xong Corel X5 sẽ cho phép bạn chụp màn hình với COREL 

CAPTURE. Bạn chỉ cần bấn phím F7 hoặc phím nóng do bạn thiết lập. Corel sẽ cho 

phép bạn chụp màn hình cực đẹp với chất lượng tối ưu cho in ấn. Tôi đã thử chụp màn 

hình từ COREL X5 và mang đi in ấn. Chất lượng khỏi chê. 

Dưới đây là hình ảnh tôi chụp xong từ trang web trên internet và dùng corel capture 

X5 (độ phân giải : 300 dpi, độ thu phóng: 600 %) để chụp. Kết quả kiểm tra bằng 

PHOTOSHOP: Cho kích thước 65 cm x 39.5 cm và 300 dpi. Nếu bạn cần kích thước 

lớn hơn bạn chọn độ thu phóng cao hơn. 
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3. Thực hành 

3.1 Thực hiện các thao tác trên Corel PhotoPaint 

3.2 Thực hiện các thao tác trên Corel Capture 

4. Kiểm tra 

Thiết Kế Brochure 
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